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Introduction and Contents
Blue Ridge Technologies® | Essentials Help

Overview
Essentials™ software is employed with Tech Kit 3.0 to configure all Aperio® and M3 Platform products.

This help system is your guide to using Essentials and configuring systems to your needs.

A video demonstrating the Essentials software is available at the link
Essentials Tutorial.
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Concepts and Definitions
Blue Ridge Technologies® | Essentials Help

Overview
This page defines basic concepts and controls
used throughout Essentials.

What do you want to do?
Identify Physical Terms
Identify Logical Terms
Identify BACnet Terms
Identify Control Terms

Identify Physical Terms
Physical Tree: This view is used to add hardware
to a System, define its properties, and establish
its relationships to other hardware. At times some have also used the term Network Tree to refer to it.

Router : The IP to BACnet MS/TP Router is the entry point and root of a physical BACnet network segment and allows Essentials remote
configurability over IP.

Control Module : A lighting control unit which resides on the
BACnet network. It contains all the configuration settings for the operation
of the devices it is connected to.

I/O Module : A Control Module expander providing additional
input/output capacity. It resides on a CANbus shared with other I/O Modules and Stations that are all under
the management of the parent Control Module.

Station : A user interface which resides on the
CANbus network. A Station provides ON/OFF,
raise/lower, or preset control to the occupant.

Preset : A stored light level or state initiated by a
designated button on a Station.

Universal Input (UI) : An input configurable for use with
various field devices including switches, occupancy sensors, and
light sensors.

Relay Output (RO) : An output which provides ON/OFF
control of the lighting load.

Digital Output (DO) : An output which provides ON/OFF
control of the lighting load.

Analog Output (AO) : An output which provides level
control for dimmable lighting.

Tri-State Output (TSO) : An output which provides
control for shade control channels.

Load Status Input (LSI) : An input which provides a live
indicator as to a load's state (ON or OFF).

Line Voltage Input (LVI) : An input for use with line
voltage switches.

Name : All inputs and outputs have a fixed Name field
for use in Essentials only, allowing for consistent input/output identification throughout Essentials. The
default Name convention follows this format:

[Input/Output Type]—[2-digit I/O Module Address (00=Control Module)]—[2-digit Input/Output Number].

Example One: UI-05-04

UI=Universal Input

05=IO Module Address 5

04=Input Number 4

Example Two: RO-00-01

RO=Relay Output

00=I/O Module Address 0 (Indicates a Control Module)

01=Output Number 1

AKA : An optional editable field for each input and output. This field gives system designers the option of adding an
additional, memorable label for a piece of I/O. This may be of use when assigning the I/O to a
Channel or using a naming
convention adhered to by a third-party.

Identify Logical Terms
Logical Tree : This view is used to geographically
organize a System and assign hardware control of a space.

System : This defines lighting control hardware and the
space it controls. System is a contextual term and may be
scaled from a single building to a campus or multiple campuses. A
System is created in Essentials
before beginning configuration.

Area : A logical division of a System used to
create manageable spaces for configuration.

Zone : A division of an Area determined by
scheduling needs, control strategies, or hardware limitations.

Channel : A division of a Zone where the
relationships between inputs and outputs are established and the
logic is executed.

Identify BACnet Terms
BACnet Tree: This view provides a listing of the exposed BACnet points
of a System. If a BACnet point is visible in this tree, any connected BACnet management
tool should be able to discover and read the point's
current properties including its Present Value.


For a complete description of the types, naming, numbering and properties of Blue Ridge's BACnet points
please see the document BACnet Points List

Analog Value (AV) : A data value over a range of numbers. Precision varies depending on what the point describes. An example is CHANNEL_LEVEL.

Binary Value (BV) : A data value of 1 or 0 representing ON or OFF. An example is CHANNEL_STATUS.

Multi-State Value (MSV) : A discrete, enumerated set of data values
each representing a different mode of a device, such as VS_LEVEL_SET.

Identify Control Terms
File Menu

Connect : This establishes Essentials communication with
all reachable Control Modules in a system. To Connect to a Control Module
select the Control Module or assigned Zone in the
tree structure, select Connect,
and chose a connection method.

Disconnect : This terminates Essentials' communication
with a Control Module.

Configure Menu

Add : This adds components (Area, Zone, Router,
Control Module, etc.) to a System.

Send Settings : This sends local Essentials settings to
the Control Module.

Retrieve Settings : This imports a Control Module's
settings into Essentials.

Retry Connection : This attempts to restore a lost connection with a
Control Module.

Move Up and Move Down : These organization tools
move the selected item in the Logical Tree or Physical
Tree within the tree structure.

Delete and Rename : These affect the selected
item in the Physical Tree or Logical Tree.

Tools Menu

Load Control Module : This loads firmware to a Control Module.
For more information on loading firmware visit the Downloads Page (an internet connection is required for this link).



Email Tech Support : This collects the current Essentials system file as
well as relevant log files into a .ZIP file and places it on the Desktop. It also composes
an email to Blue Ridge Tech Support with the relevant
fields pre-filled out. The email's body instructs the user to drag the .ZIP to the email as an attachment and then send.

Preferences : Preferences : This adjusts the polling rate of Essentials.
When connected to a remote system, it governs the frequency with which live data
(I/O statuses, Channel Status, etc.) is read from the relevant
Control Module.
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Router: General Settings
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Overview
Router: General Settings allows communication to be established with the router and grants Essentials remote configurability over IP. Note that a system must be created in Essentials before
adding a
router and beginning configuration.

Configure Router Settings
Router: General Settings defines a router's BACnet communication parameters.

Router: General Settings is composed of four
settings. These settings should match those of the appropriate
router.
MS/TP Network : The MS/TP network number
is a 16-bit value (1-65534) that identifies the network within
the BACnet internetwork. Each network has its own unique number. No other networks, regardless of type,
may have the same number.

BACnet/IP Network : The BACnet/IP network number
is a 16-bit value (1-65534). As above, each network must have its own unique
number. See below for special considerations for this field.

IP Address : The IP address of
the BACnet router.

Port Number : The UDP port number that the router is listening for BACnet/IP traffic upon. Very often this is going to be 47808 (0xBAC0) or 47809 (0xBAC1). Check the router's admin/setiings page to confirm.

Additional Router Configuration Tips
The BACnet standard mandates that each network on a BACnet internetwork (i.e. a network of networks) have a unique network number. Furthermore, the topology of the internetwork
must not have
any loops. That is, for the sake of BACnet routers there must be only
one path across networks between a source and destination network. Essentials makes a best effort to help a system author
enforce this by performing
vailidation on the router settings fields, not just for syntactic correctness, but also to catch numbering conflicts.

When building a multi-router Essentials system, the implicit assumption is that
the MS/TP networks will be branches off of an IP-based trunk network. Thus every
router should have a different
MS/TP Network number. Essentials will show a warning if an MS/TP network number is reused on another router whether in the MS/TP Network or BACnet/IP Network fields.

Returning to the trunk topology, each of the routers in a multi-router system off of a common IP trunk should have the same BACnet/IP Network number. This is the most commonly encountered
setup by far. However, if the routers do reside on seperate IP subnets then different BACnet/IP network numbers are warranted for each router.
Ultimately, it falls to the system author to know the
settings of their router(s) and the topology of their internetwork.
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Control Module: General Settings
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Overview
General Settings allows selecting the type of Control Module,
viewing the firmware version and potentially the serial ID, boot time, & boot count of the Control Module, setting the time and date within
the Control Module, selecting how the
Control Module responds to network time synchronization and daylight
savings changes, configuring its DMX mode if applicable, and monitoring its I/O Modules
CAN bus status via BACnet.

What do you want to do?
Select a Control Module Type
View Device Information
Set the Time and Date
Disable BACnet Time Synchronization
Configure Local BACnet Time Synchronization 
Configure UTC BACnet Time Synchronization 
Sync Time with Local BACnet Time Synchronization 
Sync Time with UTC BACnet Time Synchronization 
Configure a Controller for DMX
Configure IOM CAN Status BACnet Points Enable 
Do Not Contact

Select a Control Module Type

1. The Control Module Type list may be filtered to show
a subset of available choices.

Check Show Legacy to include BRT Control Modules no longer
sold in the Control Module Type list.

Select the desired Secondary Comm choice to show either "All" Control Modules,
"DMX" for only DMX-capable Control Modules, or "None" to display only those Control Modules
with no DMX capability in the
Control Module Type list.

2. Choose a control module type from the drop down list. The
control module type must match the type of the actual control module
installed in the field. A mismatch will cause sending/retrieving
control module
settings and firmware loading to fail.

Once the selected control module type has been assigned, it
can be changed at a later time only if the change wouldn't
conflict with obligations subsequently made for the soon-to-be former
control module type.
For instance, if the type is adding capability, e.g. DMX or more I/O Module capacity, nothing in the system as yet authored would contradict that. If however one is changing to a module type that reduces capability,
such as the number of permitted I/O Modules, while having already added all of those I/O Modules, the user will be warned and the the impacted channel, I/O Module, and station assignments for the control
module will be removed.
As always, the new type must match the actual control module type in the field.

3. Save and send settings.

View Device Information

When Essentials has been connected to a system, the above Device Information
fields will populate, providing helpful diagnostic information.


- Firmware Version will show the revision of firmware currently running the Control Module.


- Serial Number will display the ID and factory date of the Control Module.


- Boot Time will display the date and time of the most recent start of the Control Module. (This information will only appear on Control Modules running firmware 4.1.0 or newer.)


- Boot Count will display the number of times the Control Module has been power cycled. This can be of use in diagnosing power reliability issues. (This information will only appear on Control
Modules running firmware 4.1.0 or newer.)


Set the time and date

1. If not connected, Connect
to the system. The Time and Date fields will populate with the
Control Module's Time and Date.

2. Set the Time and Date using one of the three methods
below:
1. Manually enter the Time and Date in the appropriate fields.
2. Press the Reset Local button to populate the Time and Date
fields to the PC's Time and Date.

3. Write to the local-time and local-date properties
of the BACnet device object.

After the first two methods, the time and date will have a slowly pulsating blue border
accompanied by a mouseover tool-tip stating that the local time has been altered and no longer
agrees with the Control
Module's onboard time. This border emphasis will persist until the locally altered time is sent/synced with the Control Module or until the system is disconnected, whichever comes first.



3. To send the time and date displayed in Essentials to the Control Module, press the Sync Time button. This will sync to the currently selected Control Module only.
A confirmation will be displayed and the blue
border around the date and time noting the prior non-synchrony will disappear.
If it is desired to set the date and time of other devices on the BACnet internetwork in addition to the the Control Module, check the box to the right of Sync Time, Broadcast Sync, before pressing Sync Time. This
will cause the currently selected Control Module to broadcast the time and date as a BACnet Time Sync broadcast in addition to setting its own date and time.
The type of Time Sync broadcast that the Control Module sends will be determined by the choice in the BACnet Time Sync radio button panel. If the choice is None or Local, the broadcast sent will contain the
unadorned time and date with no time zone information. It will be processed after receipt only by those devices that have the BACnet Time Sync service enabled. If the choice is UTC, the broadcast sent will contain
the UTC time and date with time zone offset information. It will be processed after receipt only by those devices having the BACnet UTC Time Sync service enabled. 
For receiving such a broadcast, each Blue Ridge Control Module should have BACnet Time Sync radio button panel tuned to Local or UTC as desired (and those settings residing on the Control Module.) For 3rd
party devices, the means of enabling Time Sync or UTC Time Sync service are a local matter. Any device supporting the matching service on the internetwork that receives the broadcast will update its date and
time, regardless of broadcaster. (The BACnet Time Sync and UTC Time Sync services do not have a mechanism to whitelist a set of Time Sync 'server' MAC addresses. On a multi-verndor site be aware that
broadcast could potentially set the date and time of any reachable device.)
A Send Settings will also sync the time, but does many other things in addition. It is likely more than one wants to just update the time and date.

Disable BACnet Time Synchronization

1. Select the None radio button.

2. Select the appropriate time zone from the drop-down menu.
The control module will automatically adjust its on-board time for daylight savings time
based on the time zone selected.
3. Save and send
settings.

Configure Local BACnet Time Synchronization

1. Select the Local radio button. This will enable the control module to process BACnet TimeSynchronization service requests. It also enables the Local_Date and Local_Time properties when viewing the control
module's Device Object via a BACnet client. When the (Local) TimeSynchronization BACnet service request is received, the device will update its time and date accordingly. Note that with this service, the device
does no further processing of the time and date. Notably, no daylight savings offset is applied. It is up to whomever is sending the TimeSync requests to keep that in order. As such the time zone drop-down is
greyed out as it is not applicable.

2. Save and send
settings.

Configure UTC BACnet Time Synchronization

1. Select the UTC radio button. This will enable the control module to process BACnet UTC TimeSynchronization service requests. It also enables the Local_Date, Local_Time, UTC_Offset, and
Daylight_Savings_Status properties when viewing the control module's Device Object via a BACnet client. When the UTC TimeSynchronization BACnet service request is received, the controller will
updates its
local time and date accordingly.

2. Select the appropriate time zone from the drop-down menu.
The UTC_Offset property of the device object will display the
offset based on the time zone selected. Additionally, the control module will
automatically
adjust for daylight savings time based on the time zone selected. The status of daylight savings time is readable for BACnet clients using the Daylight_Savings_Status property of the BACnet device object.

3. Save and send
settings.

Sync Time with Local BACnet Time Synchronization

1. To configure a Local BACnet Time Sync broadcast request emanating from
your control module,
press the Sync Time button while the Broadcast Sync box is checked and while connected to the system. A
broadcast will be sent to all network controllers that have Local Time Sync enabled.

This will not only affect BRT controllers but any BACnet
device on the network that has its local time
synchronization service enabled.

2. If the sending Control Module's BACnet Time Sync is set to None,
then it will broadcast to receiving controllers set to Local.

3. Save and send
settings.

Sync Time with UTC BACnet Time Synchronization

1. To configure a BACnet UTC Time Sync broadcast request emanating from
your control module, press the Sync
Time button while the Broadcast Sync box is checked and while conntected to the system. A
broadcast will be sent to all network controllers that have UTC Time Sync enabled.

This will not only affect BRT controllers but any BACnet
device on the network that has its UTC time
synchronization service enabled.

2. Save and send
settings.

Configure a Control Module for DMX

1. From the Control Module Type list, select a Control Module Type
that supports DMX (any ending in "D").

2. Choose one of None, Transmit, or Receive from the DMX512 Mode section.
None - This Control Module will not send or receive DMX data.
Transmit - This Control Module will act as the DMX master and send commands to DMX RX devices. Selecting this mode will enable one to add DMX
Devices under the Control Module's on the Physical Tree. To configure what DMX channel commands are
sent, configure the Control Module's
BRT Channels on the Logical Tree.
Receive - This Controller will act as a DMX slave and react to DMX commands from the transmitting DMX device on the bus.
To configure what DMX channel(s) the Control Module will react to, configure in the Control Module's BRT Channels on the Logical
Tree.

3. Optional: Add a DMX Device.

4. Save and send settings.



Configure IOM CAN Status BACnet Points

1. When enabled, a Read-Only Binary Value (BV) BACnet point will be present for each I/O Module in the system file. The option's default is Enabled. The option will appear only if the Control Module is found to be
running firmware version 4.1.0 or newer.

Each BV will have the name IOM_CAN_STATUS_14000XX and ID number 140000XX where XX is the CAN address number of the I/O Module.

The BV's Present Value will be 0 if the I/O Module has not been heard from by the Control Module via the CAN for more than a heartbeat period.

The BV's Present Value will be 1 if the I/O Module has been heard from as a duration of one heartbeat.

Finally, the description property of each BV will contain the a timestamp of the last CAN bus communication from the I/O Module.
This feature is useful for monitoring missing or offline I/O Modules via a BACnet
point viewer of one's choosing. .

2. Save and send
settings.

Do Not Contact

This feature is specific to Essentials only and its behavior when connected to a system. Click on the chain link icon to the left of the Control Module on the Physical Network tree.
When selected, a red line
appears through the chain link and the tree row is greyed out.




This in turn directs Essentials not to attempt communication with this control module and its children when connected to the larger system.

This is useful in situations where control modules have been authored in Essentials but are not yet physically present on the actual network. This saves Essentials the time and bandwidth of repeated attempts
to poll and attempt connection with a control module that is purposely offline (e.g. turned off, unwired, or simply not present).
Another scenario is when one wants to focus on the Zones of one Control Module
and exclude others. Finally, it prevents Essentials from raising a false positive warning that it cannot connect with the Control Module.
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Overview
Relay Panels, Modular Controllers, and Zone Controllers communicate using BACnet MS/TP. This section allows the user to establish a Control Module's identity within the
BACnet MS/TP network.




Configure Communication Settings
Communication Settings defines a controller's BACnet and MS/TP
communication parameters.

1. Select the media access control (MAC) address for the controller.
Each controller must have a unique MAC address on a BACnet MS/TP network segment. Possible MAC address values are [1-99].
2. Set the controller's Device Object ID. Each controller must have a unique Device Object ID on a BACnet internetwork. The Device Object ID may be customized with possible
values of [0-4194302]. The default

device
object ID follows the format (132YYXX) where:
132 = Blue Ridge Technologies Vendor ID
YY = Two digit router number. Each router in
a system is allocated a distinct number, starting at 1, in order of router creation
XX = MAC Address

3. Set a Device Object Name. This customizable controller name, will be visible at the "Name" property of the BACnet Device Object by BACnet clients.
4. Set the Device Object Description as an up to 127 character length string. It will be visible as the "Description" property of the BACnet Device Object by BACnet clients. The property may also be customized via a

BACnet client. (This option will appear only on Control Modules running firmware version 4.1.0 and up.)

5. Choose a value for Max Masters. A property of the device object, Max Masters is the highest address that will be polled on a BACnet MS/TP network segment by the selected
controller. In the vast majority of
situations this will only need to be set on the highest
addressed controller on the MS/TP segment. Possible values are [1-127].

6. Choose a value for Max Info Frames. A property of the Device Object relevant to MS/TP networks, Max Info Frames
stipulates the number of consecutive request packets a control module (AKA an MS/TP master
node)
may utilize if needed before relinquishing control of the MS/TP network by passing the token to the next master node.
Possible values are [1-127]. Five is the default,
and provides an equitable balance for
bandwidth sharing.

7. Save and send settings.
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DMX Device: General Settings
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Overview
A DMX Device is any fixture controlled by the Digital Multiplex (DMX512) protocol. DMX512 is a standard for digital communications across a universe of 512 channels. (DMX's use of the term
'channel'
is distinct from Blue Ridge's use of the term. In DMX it is akin to a 'lane' for communicating a singe value.) Each DMX channel is commanded to a value ranging from 0-255. DMX receiving
devices customarily map a channel to a specfic lighting effect. Examples of qualities represented by a DMX channel on a device are: color strength (red, green, blue), overall intensity, strobe or pulse
periodicity, etc.

What do you want to do?
Add a DMX Device
Configure DMX Settings

Add a DMX Device

1. Right-click on the Controller in the navigation pane on the left side of Essentials. Click on Add DMX Device. A New DMX Device will be added underneath the controller.

2. If desired, change the default name. This can be done at any time by right-clicking on the DMX device and selecting "Rename". This customizable name allows device identification throughout Essentials.

Configure DMX Settings

1. The Base Address represents the first DMX Channel that will be used by the current DMX Device. For example, if this is the first DMX Device in the network, then by default, the Base Address will be DMX Channel
1. If it is not the first DMX Device in the network, then the Base Address will default to the first available DMX channel on the network.

2. The Number of DMX Channels can also be changed — from 1 channel up to
the maximum allowable limit based on DMX Controller Type. The number of DMX channels that can be allocated to a specific device
will also be limited based on the total number of DMX Devices on the network. 


The total number of DMX channels available to a Control Module depends on the model. The capacities are as follows CM02TD : 16, CM04TD : 32, CM08TD : 64, CM16TD : 128, CM32TD : 512. The DMX
channels are apportioned contiguously across DMX devices starting from 1. Most DMX Rx devices have more than one channel addressable on the device. However, in the limit one could conceivably have one
DMX channel per DMX device.

3. If desired, a label can be added in the Description field of each DMX Channel assigned to the DMX device. This can be helpful in specifying what lighting effect each DMX Channel controls (for example, DMX
Channel 2 could be designated to control red lights while DMX Channel 3 could be used to
control green lights, etc.).

4. Make note of the Status section. When connected to a controller, Status displays the value (0-255) at which the DMX Channel is currently set.

5. Use Lock to set a DMX Channel to a specified value (0-255). To enable or disable the Lock, select the lock icon. Please note Lock is a powerful diagnostic tool that disables all occupant control of the output and
may not be disabled outside of Essentials. Use Lock with care.

6. Use Min Value and Max Value to set Min and Max range values on the DMX Channel output. A value of 0 represents "off", and any value (1-255) represents the light turned "on". Generally, the higher the value, the
brighter the light will be (or increased strobe effect, etc.).

7. Save and send settings.
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Overview
Blue Ridge Technologies controllers can be connected to using IP, and both Bluetooth and USB connectivity with additional hardware. Connect allows the user to connect to a controller or network of
controllers using one of the three aforementioned methods. Note that an Essentials system must be created and contain the controller with the
correct address before the Connect window can be
accessed.

What do you want to do?
Connect via Bluetooth
Connect via IP
Connect via USB

Connect via Bluetooth

1. Verify that your controller's Bluetooth is linked with your computer. If you have not yet taken the time to pair
the controller with your computer, instructions on how to do
so can be found
here
(an internet connection
is required for this link),

2. If a system has not yet been created, set one up now by clicking File > New on the task bar.

3. Add the controller you wish to connect to and set the address
under Controller Communication Settings.

4. Access the Connect window either by clicking File > Connect on the task bar, or by using the hotkey command, Ctrl+Shift+C.

5. Select the BT: option for your Bluetooth device
and click Connect.

Connect via IP

1. If a system has not yet been created, set one up now by clicking File > New on the task bar.

2. Verify that a router has been added to the network tree.
If a router has not been added, the option to connect via IP
will not be presented on the Connect window. To add a router,
right click on the system level in
the network tree and click "Add Router".
Instructions on how to configure the router can be found in the
General Settings of the router page.

3. Add the controller you wish to connect to and set the address
under Controller Communication Settings.

4. Access the Connect window either by clicking File > Connect on the task bar, or by using the hotkey command, Ctrl+Shift+C.

5. Select the IP Connection option and click Connect.

Connect via USB

1. Verify that your firmware is at least version 3.5 or higher.

2. If a system has not yet been created, set one up now by clicking File > New on the task bar.

3. Add the controller you wish to connect to and set the address
under Controller Communication Settings.

4. Access the Connect window either by clicking File > Connect on the task bar, or by using the hotkey command, Ctrl+Shift+C.

5. Select the USB option and click Connect.
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Overview
Send Settings allows the user to synchronize a configuration file with a Control Module or network of Control Modules.

Send Settings to a Control Module
1. Choose File > Save or click the Save button to save
changes to the .brt file.

2. If not connected, Connect
to the system.

3. Choose Configure > Send Settings to write changes to
the Control Module. The choice of settings sent will be dependent on the
present tree selection in the left side Logical or Physical tree panel.
If an entity that
encompasses more than one Control Module is selected,
such as a Router or Area, then settings will be sent
to each of the Control Modules underneath that entity.
In such, a multi-Control Module send settings
case,
a summary pop-up window will be
provided at the conclusion, detailing to which Control Modules settings were sent successfully, and, if any were unsuccessful, the reasons why.
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I/O Module: General Settings
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Overview
I/O Modules are discrete devices, local to a given Control Module, which augment the amount of inputs and outputs available to
the zones managed by that control module.
I/O Modules extend the
abilities of a Control Module by providing additional input/output capacity. I/O Modules reside on a Control Module's private CANbus Network.
The quantity and type of I/O Modules that may be
attached to
a given control module is governed by the type of the parent Control Module.

What do you want to do?
Configure an I/O Module by Type and Address
Serial Number and Firmware Version of I/O Module
Configure an AO Expander by serial address
CANbus Notifications

Configure an I/O Module by Type and Address
General Settings define an I/O Module's hardware type and communication characteristics.




1. Choose an I/O Module Type from the drop-down list. The I/O Module Type must match the physical type installed in the field.

Select the Show Legacy checkbox to display discontinued
product types in the drop-down list.

Once the selected I/O Module type has had any of its I/O assigned within a channel, further changing the I/O Module type will cause channel assignments for I/O on the I/O Module to be removed from all the
assigned channels.

2. Choose an Address from the drop-down list.
Each I/O Module must have a unique Address.
Helpfully, Essentials will enforce this constraint for a user.
For example, if a Control Module already has an I/O Module
using the Address "1", then the Address drop-down list of a subsequently added I/O Module will not offer the Address "1". In general,
when adding new a I/O Module, Essentials will automatically select the lowest
available address for the user.



When selecting an Address there
are three other considerations to be aware of:



First, though a given Control Module may be limited in
the total quantity of I/O Modules it may utilize, the entirety of the I/O Module address range is available as a choice for the I/O Module's specific address.
The
address range for I/O Modules is 1-32 inclusive.



Second, though I/O Modules share a given Control Module's CANbus with Stations, their address space is separate from Stations' address space.	The Control Module knows how to distinguish Stations from I/O
Modules on the CANbus, first by device class, and then by address.
For example, one may have a Station with Address "1" and an I/O Module with Address "1" with no conflicting issues. Tellingly, using a given
number for a Station address will not make that number disappear from the I/O Module
Address drop-down list. 


Finally, none of these Essentials addressing safeguards is a substitute
for the correct setting of the rotaries on the I/O Module.
The rotary settings must be within I/O Module address range and must match the
Address and Type found in Essentials. There is nothing to physically prevent one from using duplicate
I/O Module rotary addresses on the CANbus.
If this happens, it will result in communication errors between
the Control Module
and the duplicatively addressed I/O Modules. If such a duplicate situation is uncovered during inspection, just change the rotary while the I/O Module or Station is running. More recent I/O
Module and Station firmwares automatically update the address they use to communicate within thirty seconds after their rotaries are changed during operation. This happen without needing a reboot/power cycle,
as required in older firmwwares.

3. Save and send settings.

Serial Number and Firmware Version of I/O Module
The Serial Number and Firmware Version of non-legacy I/O Modules are reported to the Control Module over the CANbus.
While connected to the Control Module via Essentials, this field will auto-
populate based on the I/O Module at this address. This can help to ensure that the correct I/O Module is reporting
back for that address, by cross-checking the serial number
printed on the I/O
Module board in the field.

Configure a legacy AO08v1 I/O Module by serial address
Version 1 of the AO08 analog output board utilized serial numbers instead of rotary dials to set a couple for an address. These require the serial number to be input into Essentials and sent to the
Control Module in order for the Control Module to communicate with the I/O Module.

1. Choose an Address from the drop-down list.
Each I/O Module must have a unique Address. The Address must be different from
Addressable I/O Modules in the field. (i.e all other I/O Module types, which are
selected
by use of rotary dial).



2. Choose the AO08v1 aka 8 Analog Outputs
with Serial Number Addressing from the drop-down list.

An AO08 with rotary dial addressing will use the AO08
I/O Module Type from that drop-down list along with the
"8 Analog Outputs" mouseover description.

3. The Serial Number printed on the board, must be manually entered into the field. This will allow the Control Module to send messages to the I/O Module based on serial number
instead of by address.

4. Save and send settings.

CANbus Notifications
All non-legacy I/O Modules have the on-board ability to visually notify a technician of ongoing CANbus communication issues
via LED signaling.




1. Loss of CANbus communication will result in the
RUN LED blinking three times in rapid succession,
followed by an off period, and then repeating.
This indicates that the CANbus has accumulated enough errors
over a recent time frame to consider the CANbus to be down. Through this, the I/O Module will continue to attempt communication over the CANbus. Once enough successful messages
have been sent, the error
tally will be cleared
and the periodic three blinks will stop. There are a few things that may cause this blinking to happen.

The End-of-Lines are not terminated and causing the communications to fail.
There could be a loose connection to the I/O Module.
There may be a short in the communication cable.

2. If the I/O Module does not receive communication from the Control Module, the RUN LED on the I/O Module will flash two times. There are a few things that may cause this blinking to happen.
The Control Module may not be powered on.
The Control Module may not be wired correctly to the CANbus.
If the Control Module is running firmware version older than 3.0.0 and its system settings tell it not to expect any devices on the CANbus, it will not be attempting any communication on the CANbus.
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I/O: Universal Inputs
Blue Ridge Technologies® | Essentials Help

Overview
Universal Inputs (UI) provide wired connections to field
mounted sensing devices. Devices can be binary—sensing ON/OFF
conditions, or analog—sensing a defined range of conditions. 
Occupancy sensors, current switches, and dry contact switches are binary
devices. 

Light level sensors, temperature sensors, and humidity
sensors are analog devices.

What do you want to do?
Configure a Universal Input for a Binary Device
Configure a Universal Input for an Analog Device
Expose a Universal Input for BACnet Client Discovery
Allow a Universal Input to be assigned globally

Configure a Universal Input for a Binary Device

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: Input Type—I/O Module Address (00=Control Module)—Input Number. The Name is
used throughout Essentials when referring to the input. For example, the name UI-02-01 parses as the following: UI=Universal Input, 02=I/O Module Address 2, and 01=Input Number 1.

2. If desired, add an AKA label to the UI. It provides an additional, memorable label to more readily distinguish between UIs.
If present, the AKA label will
accompany the Name field in Channels and dropdown lists.

3. From the Type drop-down list choose the binary
signal needed for the required channel sequence. Supported signals
are described below:
1. Maintained—A sustained change from the device's
normal contact state signals ON. A sustained change to the
device's normal contact state signals OFF.
2. Momentary On/Off—A momentary transition from the
device's normal contact state, e.g. contact open, to its
alternate position signals a transition to the opposite state.
For example, if the UI state is ON, a Momentary On/Off

signal
causes the UI state to change to OFF.
3. Momentary On—A momentary change from the
device's normal contact state signals ON.
4. Momentary Off—A momentary change from the
device's normal contact state signals OFF.
5. Change of State—A sustained change from the
device's current contact state inverts the input signal. If
the current signal is OFF, it changes to ON. If the current
signal is ON, it changes to OFF.

6. Occupancy Sensor—A sustained change from the
device's normal contact state signals ON. A sustained change to
the device's normal contact state signals OFF.

Once the UI type has been chosen, and the UI has been assigned in any channels, further changing the UI type
may cause those channel assignments to be removed if the new type of the UI would render
those assignments non-applicable.

4. Change the action of the device by selecting
Normally Open or Normally Closed from the action drop-down list
located below the Type drop-down list. Normally Open means the
device signals an ON state by
closing its contacts. Normally
Closed means the device signals an ON state by opening its
contacts.

5. Save and send settings.

When connected to a system, the Status field displays the
input's current state (ON or OFF).

Configure a Universal Input for an Analog Device

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: Input Type—I/O Module Address (00=Control Module)—Input Number. The Name is
used throughout Essentials when referring to the input. For example, the name UI-02-01 parses as the following: UI=Universal Input, 02=I/O Module Address 2, and 01=Input Number 1.

2. If desired, add an AKA label to the UI. It provides an additional, memorable label to more readily distinguish between UIs.
If present, the AKA label will
accompany the Name field in Channels and dropdown lists.

3. From the Type drop-down list choose the analog
signal needed for the field device. Supported signals are 4-20mA,
0-5Vdc, and 0-10Vdc.

4. Calibration settings allow compensation for variance
in sensor signal values (Vdc or mA). Generally these values should
be left to default.

5. In the Device Range section, enter the minimum and
maximum sensed values for the device. For example, for a 0-100 fc
sensor enter 0 for the minimum and 100 for the maximum. Don't forget to configure these
otherwise your device will appear to have no range. Even though the input voltage will vary,
the interpretation into units along the range will map to 0.

6. Choose the measurement units for device range values in
the Units drop-down list. Light level sensors
can be configured for either foot-candles (fc) or lux (lx).

7. Save and send settings.

When connected to a system, the Status field displays the
input's current sensed light level in foot-candles or lux.




Expose a Universal Input for BACnet Client
Discovery

1. Check the BACnet checkbox. The point type will alter according to
whether the input is set to a Binary Input type or an Analog Input type.

2. Save and send settings.

Allow a Universal Input to be assigned globally

By allowing a Universal Input to be assigned globally, it will be selectable where point assignments are made. For example, when
an occupancy sensor UI is allowed to be global, it will show up in the
occupancy sensor assignment dropdown list of every Channel's "Occupancy Sensor" section. It does not matter if that Channel's Zone is bound to a different control module.



1. Check the Global checkbox. Note that when the Global
checkbox is checked, the BACnet checkbox will in turn be force checked. Universal inputs available globally must also be exposed as BACnet points. This is
because the changes to the UI's present value are shared via BACnet
COV (change of value) broadcasts.

2. The following types of Universal Input may be made Global:
1. Maintained
2. Momentary On
3. Momentary Off

4. 4-20mA
5. 0-5Vdc
6. 0-10Vdc
7. Occupancy Sensor

3. Save and send settings.
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I/O: Digital Inputs
Blue Ridge Technologies® | Essentials Help

Overview
Digital Inputs (DI) provide a wired connection to field
mounted switching devices. Devices are binary, sensing ON/OFF
conditions. Occupancy sensors, current switches, and dry contact switches are
examples of binary devices.

What do you want to do?
Configure a Digital Input
Expose a Digital Input for BACnet
Client Discovery
Allow a Digital Input to be
assigned globally

Configure a Digital Input for a Binary Device

1. If desired, change the input name from its default in the Name field. The digital input's Name is customizable and allows input identification throughout Essentials. The default Name follows this format (Input Type -
I/O Module Address (00=Control Module) - Input Number). For example, for DI-02-01,
DI=Digital Input, 02=I/O Module Address 2, and 01=Input Number 1.

2. From the Type drop-down list choose the binary
signal needed for the required channel sequence. Supported signals
are described below:
1. Maintained—A sustained change from the device's
normal contact state signals ON. A sustained change to the
device's normal contact state signals OFF.
2. Momentary On/Off—A momentary transition from the
devices normal contact state, i.e. contact open, to its
alternate position signals a transition to the opposite state.
For example, if the UI state is ON, a Momentary On/Off signal

causes the UI state to change to OFF.
3. Momentary On—A momentary change from the
device's normal contact state signals ON.

4. Momentary Off—A momentary change from the
device's normal contact state signals OFF.
5. Change of State—A sustained change from the
device's current contact state inverts the current signal. If
the current signal is OFF, it changes to ON. If the current
signal is ON, it changes to OFF.
6. Occupancy Sensor—A sustained change from the
device's normal contact state signals ON. A sustained change to
the device's normal contact state signals OFF.

Once the DI type has been chosen, and the DI has been assigned in any channels, further changing the DI type
may cause those channel assignments to be removed if the new type of the UI would render those assignments
non-applicable.

3. Change the action of the device by selecting
Normally Open or Normally Closed from the action drop-down list
located below the Type drop-down list. Normally Open means the
device signals an ON state by
closing its contacts. Normally
Closed means the device signals an ON state by opening its
contacts.

4. Save and send settings.

When connected to a system, the Status field displays the
input's current state (ON or OFF).

Expose a Digital Input for BACnet Client
Discovery

1. Check the BACnet checkbox.

2. Save and send settings.

Allow a Digital Input to be assigned globally

By allowing a Digital Input to be assigned globally, it will be selectable where point assignments are made. For example, when
an occupancy sensor DI is enabled to be global, it will show up in the
occupancy sensor assignment drop down list in the "Occupancy Sensor
Channel" section of all channels across all control modules.

1. Check the Global checkbox. Note that when the Global
checkbox is checked that the BACnet checkbox is forced to be
checked. Points exposed globally are required to also be exposed
to BACnet because points
are made available globally via BACnet
COV (change of value) subscriptions.

2. The following types of Digital inputs may be made Global:
1. Maintained

2. Momentary On
3. Momentary Off
4. Occupancy Sensor

3. Save and send settings.

Essentials v4.1.1  © 2022 
Blue Ridge Technologies International, LLC. All Rights Reserved.



I/O: Line Voltage Inputs
Blue Ridge Technologies® | Essentials Help

Overview
Line Voltage Inputs allows custom naming, provides status,
and adjustment of characteristics. These settings apply to
control modules and I/O modules with line voltage inputs only.

What do you want to do?
Configure a Line Voltage Input
Allow a Line Voltage Input to be
assigned globally
Expose a Line Voltage Input for BACnet Client Discovery

Configure a Line Voltage Input
Line Voltage Inputs configuration is composed of six
components:

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: Input Type—I/O Module Address (00=Control Module)—Input Number. The Name is
used throughout Essentials when referring to the input. For example, the name LVI-02-01 parses as the following: LVI=Line Voltage Input, 02=I/O Module Address 2, and 01=Input Number 1.

2. If desired, add an AKA label to the LVI. It provides an additional, memorable label to more readily distinguish between LVIs.
If present, the AKA label will
accompany the Name field in Channels and dropdown lists.

3. Make note of the Status section. When connected to a control module, Status displays the input's current state (ON or OFF).

4. Select the Type to allow configuration of input type
(Maintained or Change of State). These input types have unique
operating characteristics. For example (based on normally open
input):
1. Maintained : Channel is OFF and maintained switch
is open. Switch is toggled to closed and channel turns ON.
Schedule or additional input (switch, occupancy sensor, etc.)
turns channel OFF. Maintained switch is toggled to

open and
channel remains OFF. Switch is toggled to closed and channel
turns ON.
2. Change of State : Channel is OFF and change of
state switch is open. Switch is toggled to closed and channel
turns ON. Schedule or additional input (switch, occupancy
sensor, etc.) turns channel OFF. Change of state switch is

toggled to open and channel turns ON.

5. Choose a selection under the Action tab. This allows configuration of the input action (Normally Open or Normally Closed).

6. Select the check box point to expose a
BACnet Binary Value (BV) point representing line voltage input
status to the BACnet clients. Possible values to read are
[0] OFF and [1] ON.
7. Save and send settings.

Allow a Line Voltage Input to be assigned globally

By allowing a Line Voltage Input to be assigned globally, it will be a selectable option where point assignments are made in channels of zones bound
to other controllers in the system.

 Line Voltage Inputs are only available globally when the Type is Maintained. Change of State is not offered because it represents
a relative rather than absolute interpretation of the LVI's status.

1. Check the Global checkbox. Note that when the Global
checkbox is checked, the BACnet checkbox will become checked if is not already.
This is mandatory, as the mechanism for sharing the present value of the
input
amongst control modules is by exposing a BACnet Binary Value (BV) point. Changes to the present value of this point are broadcast as unconfirmed COV (change of value)
notifications to the other control
modules.

2. Save and send settings.

Expose a Line Voltage Input for BACnet Client Discovery

1. Check the BACnet checkbox.

2. Save and send settings.
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I/O : Relay Outputs
Blue Ridge Technologies® | Essentials Help

Overview
Relay Outputs allows custom naming, displays the commanded-to position of relay, provides the load status, enables locking, shows agreement of remote lock settings with that of Essentials, allows
adjustment of the relay's contact action, and provides a quick link to the channel into which the relay has been placed.

What do you want to do?
Configure Relay Outputs with Load Status
Configure Relay Outputs without Load Status
Choose Relay Type
Control Lock Settings
Configure Relay Outputs with Adjustable Load Status

Configure Relay Outputs with Load Status

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: (Output Type—I/O Module Address (00=Control Module)—Output Number). The
Name is used throughout Essentials when referring to the output. For example, the name RO-02-01 parses as the following: RO=Relay Output, 02=I/O Module Address 2, and 01=Output Number 1.

2. If desired, add an AKA label to the RO. It provides an additional, memorable label to more readily distinguish between ROs. If present, the AKA label will accompany the Name field in Channels and dropdown lists.

3. Make note of the Cmded Value column. When connected to a controller, Cmded Value displays the current logical state to which the relay has been commanded (ON or OFF).

4. Make note of the Sensed Status section. When connected to a controller, Load Status displays the presently sensed Load Status (ON or OFF).

5. The Status Visible via BACnet column contains a check box to expose a BACnet Binary Value (BV) point representing the load status sensor monitoring this relay. Possible values to be read are [0] OFF-No Load
Sensed and [1] ON-Load Sensed.

6. Use Lock to set and lock a relay output to the specified logical state (ON or OFF). A Lock setting's physical state will be determined by the mapping based on the relay's Action configuration. To enable or disable
the Lock select the padlock icon. Please note Lock is a powerful diagnostic tool. Lock disables all BACnet and occupant control of the output and may not be disabled outside of Essentials. Use Lock with care,
being sure to Unlock when finished.

7. Make a selection in the Action column to determine how the physical state of the relay maps to its logical interpretation. The default is Normally Open, and is most commonly seen. This means that the relay is
logically OFF when open and logically ON when closed. Conversely, if Normally Closed is chosen it will mean that the relay is logically OFF when closed and logically ON when open.

8. The Ch Assignment column displays the name of the channel that the relay has been placed. The name can be clicked upon to visit the logical tree location and panel for that channel. If the relay is not in a channel
the label will read None. If the author has made the channel and zone the empty string then the name label will be auto generated as Z-xx:Ch-y, where xx is the zone number and y the channel number on the
zone.

9. Save and send settings.

Configure Relay Outputs without Load Status

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: (Output Type—I/O Module Address (00=Control Module)—Output Number). The
Name is used throughout Essentials when referring to the output. For example, the name RO-02-01 parses as the following: RO=Relay Output, 02=I/O Module Address 2, and 01=Output Number 1.

2. If desired, add an AKA label to the RO. It provides an additional, memorable label to more readily distinguish between ROs.
If present, the AKA label will accompany the Name field in Channels and dropdown lists.

3. Make note of the Cmded Value column. When connected to a
controller, Cmded Value displays the current logical state to which the relay has been commanded (ON or OFF).

4. Use Lock to set and lock a relay output to the specified logical state (ON or OFF). A Lock setting's physical state will be determined by the mapping based on the relay's Action configuration. To enable or disable
the Lock select the padlock icon. Please note Lock is a powerful diagnostic tool. Lock disables all BACnet and occupant control of the output and may not be disabled outside of Essentials. Use Lock with care,
being sure to Unlock when finished.

5. Make a selection in the Action column to determine how the physical state of the relay maps to its logical interpretation. The default is Normally Open, and is most commonly seen. This means that the relay is
logically OFF when open and logically ON when closed. Conversely, if Normally Closed is chosen it will mean that the relay is logically OFF when closed and logically ON when open.

6. The Ch Assignment column displays the name of the channel that the relay has been placed. The name can be clicked upon to visit the logical tree location and panel for that channel. If the relay is not in a channel
the label will read None. If the author has made the channel and zone the empty string then the name label will be auto generated as Z-xx:Ch-y, where xx is the zone number and y the channel number on the
zone.

7. Save and send settings.

Choose Relay Type

1. Certain Blue Ridge Technologies products allow configuration of the relay drivers to allow for two wire or three wire control. Before configuring the relay type, contact Blue Ridge Technologies Technical Support to
ensure relay	compatibility.

2. From the Relay Type drop down list chose either Two Wire or Three Wire as appropriate for your installed relay.
1. A Two Wire relay, such as the Douglas WR-6161, a Two Wire type with no load status available.
2. A Three Wire relay, such as the GE RR7, is a Three Wire type with no load status available.
3. A Five Wire relay, such as the GE RR9, is a Three Wire type with two wires dedicated to load status.

3. Save and send settings.



Control Lock Settings

While Essentials is connected, a circular 'traffic light' indicator will appear on the right side of the Lock settings column. If the indicator is green, the lock settings of that output on the remote device
agree with those on screen in Essentials.

If the indicator is red, the local on screen settings and the remote lock settings disagree. They either disagree about whether the output is locked in the first place (i.e. the padlock). Or, if locked, what
it is locked to.

To 'fix' this disagreement, simply click the red indicator and the on screen lock settings will be pushed to the remote device, followed by the indicator turning green and an on screen confirmation of a
successful send.

As noted elsewhere, Lock is a powerful diagnostic tool. Lock disables all BACnet and occupant control of the output and may not be disabled outside of Essentials. Use Lock with care, being sure to
Unlock when finished.

Configure Relay Outputs with Adjustable Load Status

In certain specialized cases, an operator may want to change the threshold that determines whether the current load on a relay counts as ON or OFF.

This advanced feature is recommended only for those operators whose needs are not met by the default threshold.

To underscore this, the feature is not visible unless the option has been enabled in the "Tools" menu like so:





Additionally, the I/O Module(s) on which the Relays reside must be running sufficiently modern firmware.

RE04 & RO04: version 6 or higher

RE224 & RO224: version 4 or higher


If the option is selected in "Tools", and the I/O Module in question has not yet been connected to, meaning its firmware version is as yet unknown, the configuration slider will still appear, giving the
benefit of the doubt and making offline system authoring more convienient. 

If however, when Essentials connects to the system at a later time, the I/O Module's firmware version is not recent enough, then the threshold slider will disappear for that Module thereafter, as it is
not applicable.

If the above conditions for Adjustable Load Status Threshold are met, then while Essentials is connected, a circular 'traffic light' indicator will appear to the right side of the LS Threshold settings row. If
the indicator is green, the LS Threshold setting of that Relay on the remote device agrees with the on-screen slider in Essentials. If not, the indicator will be red and the remote device's threshold
setting will be displayed. At that point an operator may either click the red light to push the local setting out to the remote, or adjust the local slider to the displayed remote setting so that the two will
be in agreement, in both cases returning the indicator to green.

The local setting, if different, will also be pushed out to the remote during the larger, Send Settings operation.

Essentials v4.1.1  © 2022 
Blue Ridge Technologies International, LLC. All Rights Reserved.



I/O : Digital Outputs
Blue Ridge Technologies® | Essentials Help

Overview
Digital Outputs allows custom naming, displays the commanded-value of the output, enables locking, shows agreement of remote lock settings with that of Essentials, allows adjustment of the digital
output's contact action, and provides a quick link to the channel into which the digital output been grouped.

What do you want to do?
Configure Digital Outputs
Control Lock Settings

Configure Digital Outputs

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: (Output Type—I/O Module Address (00=Control Module)—Output Number). The
Name is used throughout Essentials when referring to the output. For example, the name DO-02-01 parses as the following: DO=Digital Output, 02=I/O Module Address 2, and 01=Output Number 1.

2. If desired, add an AKA label to the DO. It provides an additional, memorable label to more readily distinguish between DOs. If present, the AKA label will accompany the Name field in Channels and dropdown lists.

3. Make note of the Cmded Value column. When connected to a controller, Cmded Value displays the current logical state to which the DO has been commanded (ON or OFF).

4. Use Lock to set and lock a digital output to the specified logical state (ON or OFF). A Lock setting's physical state will be determined by the mapping based on the digital output's Action configuration. To enable or
disable the Lock select the padlock icon. Please note Lock is a powerful diagnostic tool. Lock disables all BACnet and occupant control of the output and may not be disabled outside of Essentials. Use Lock with
care, being sure to Unlock when finished.

5. Make a selection in the Action column to determine how the physical state of the digital output maps to its logical interpretation. The default is Normally Open, and is most commonly seen. This means that the
digital output is logically OFF when open and logically ON when closed. Conversely, if Normally Closed is chosen it will mean that the digital output is logically OFF when closed and logically ON when open.

6. The Ch Assignment column displays the name of the channel that the relay has been placed. The name can be clicked upon to visit the logical tree location and panel for that channel. If the digital output is not in a
channel the label will read None. If the author has made the channel and zone the empty string then the name label will be auto generated as Z-xx:Ch-y, where xx is the zone number and y the channel number on
the zone.

7. Save and send settings.

Control Lock Settings

While Essentials is connected, a circular 'traffic light' indicator will appear on the right side of the Lock settings column. If the indicator is green, the lock settings of that output on the remote device
agree with those on screen in Essentials.

If the indicator is red, the local on screen settings and the remote lock settings disagree. They either disagree about whether the output is locked in the first place (i.e. the padlock). Or, if locked, what
it is locked to.

To 'fix' this disagreement, simply click the red indicator and the on screen lock settings will be pushed to the remote device, followed by the indicator turning green and an on screen confirmation of a
successful send.

As noted elsewhere, Lock is a powerful diagnostic tool. Lock disables all BACnet and occupant control of the output and may not be disabled outside of Essentials. Use Lock with care, being sure to
Unlock when finished.
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I/O : Analog Outputs
Blue Ridge Technologies® | Essentials Help

Overview
Analog Outputs send a specified voltage anywhere from 0 to
10Vdc to a light source. The detail panel allows custom naming, displays the commanded-to position of the analog output, enables
locking at a specific voltage, shows agreement of remote lock settings with that of Essentials, allows adjustment of the minimum and maximum voltage supported by output supports, and provides a
quick link to the channel into which the analog output has been placed.

What do you want to do?
Configure Analog Outputs
Control Lock Settings

Configure Analog Outputs

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: (Output Type—I/O Module Address (00=Control Module)—Output Number). The
Name is used throughout Essentials when referring to the output. For example, the name AO-02-01 parses as the following: AO=Analog Output, 02=I/O Module Address 2, and 01=Output Number 1.

2. If desired, add an AKA label to the AO. It provides an additional, memorable label to more readily distinguish between AOs. If present, the AKA label will accompany the Name field in Channels and dropdown lists.

3. Make note of the Cmded Value column. When connected to a controller, Cmded Value displays the current output voltage (0-10Vdc) in 1 Volt increments.

4. Use Lock to set an analog output to the specified voltage (0-10Vdc). To enable or disable the Lock, select the pad lock icon. Please note Lock is a powerful diagnostic tool. Lock disables all BACnet and occupant
control of the output and may not be disabled outside of Essentials. Use Lock with care.

5. Use Range to set Min and Max voltage range
limits on the analog output to suit hardware capability. Analog output trim adjustments for control strategies such as lumen maintenance are performed in the Analog
Output Assignment section.

6. The Ch Assignment column displays the name of the channel into which the analog output has been placed. The name can be clicked upon to visit the logical tree location and panel for that channel. If the analog
output is not in a channel the label will read None. If the author has made the channel and zone the empty string then the name label will be auto generated as Z-xx:Ch-y, where xx is the zone number and y the
channel number on the zone.

7. Save and send settings.

Control Lock Settings

While Essentials is connected, a circular 'traffic light' indicator will appear on the right side of the Lock settings column. If the indicator is green, the lock settings of that output on the remote device
agree with those on screen in Essentials.

If the indicator is red, the local on screen settings and the remote lock settings disagree. They either disagree about whether the output is locked in the first place (i.e. the padlock). Or, if locked, what
voltage it is locked to.

To 'fix' this disagreement, simply click the red indicator and the on screen lock settings will be pushed to the remote device, followed by the indicator turning green and an on screen confirmation of a
successful send.

As noted elsewhere, Lock is a powerful diagnostic tool. Lock disables all BACnet and occupant control of the output and may not be disabled outside of Essentials. Use Lock with care, being sure to
Unlock when finished.
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I/O : Tri-State Outputs
Blue Ridge Technologies® | Essentials Help

Overview
Tri-State Outputs allows custom naming and adjustment of full stroke time.

What do you want to do?
Configure Tri-State Outputs

Configure Tri-State Outputs

1. The Name field provides a consistent means for keeping track of I/O across Essentials. The default Name format is as follows: (Output Type—I/O Module Address—Output Number). The Name is used throughout
Essentials when referring to the output. For example, the name TS-02-01 parses as the following: TS=Tri-State Output, 02=I/O Module Address 2, and 01=Output Number 1.

2. If desired, add an AKA label to the Tri-State Output. It provides an additional, memorable label to more readily distinguish between Tri-State Outputs. If present, the AKA label will accompany the Name field in
Channels and dropdown lists.

3. The Stroke Time is the number of seconds it takes for the tri-state output to travel completely between its two endpoints. The permissible range is 1-120 seconds.

4. Save and send settings.
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Station: Station Settings
Blue Ridge Technologies® | Essentials Help

Overview
A Station is a capacitive touch interface that acts like a switch or set of switches that allow a user to directly control a channel or group of channels manually. They can range from single button
switch, for on and off capability, to a more advanced switch, that features light dimming and preset capabilities. Stations are wired to the Control Module via a CANbus network.

What do you want to do?
Configure a Station
CANbus Notifications

Configure a Station
Station Settings configures a station's communication and
hardware characteristics.

1. Select a Type to define the station's hardware and capabilities in Essentials. The selected Type must match the physical hardware installed on the CANbus Network.

Once the selected station type has been assigned to a channel, further changing of the station type will cause those channel assignments to be removed from all the assigned channels.

2. The "Is Version 1" checkbox is used if the station is an original Version 1 model. Both Version 1 and Version 2 are similar in faceplate appearance. However, Version 2 is distinguished by its metal frame, thin profile,
and absence of an enclosing plastic box.

3. Select a station Address. This defines a station's identity on the CANbus network. The Address in Essentials must match the Address dip switch settings on the physical station. Each Station should have a unique
Address on the CANbus network segment, relative to other stations. Stations' address range begins at 0 with the upper limit determined by the Control Module type. 


One note: Even though the CANbus wiring for a given Control Module is shared by two classes of device, Stations and I/O Modules, their respective address spaces are distinct from one another.For example, one
may set a Station at Address 1, and this does not preclude then setting an I/O Module at its Address 1. Since the I/O Modules' address space is separate it will not interfere with either devices' communications.

1. If there will be a Three-way or Four-way switch arrangement, this counts as one station on the network and each should be addressed the same at each location. This will allow each to control the same functions and react in the
correct manner.

4. A Virtual Station replicates physical Stations virtually in BACnet. Enable the Virtual check box to expose the Station's ON/OFF controls, button indicators, and level set functions as BACnet Multi State Values
(MSV). Possible values are as follows:

1. ON/OFF: [1] Toggle, [2] ON, and [3] OFF (Read/Write)
2. Button Indicator: [1] OFF, [2] ON, and [3] Flash (Read Only)
3. Level Set: [1-100] percentage of light output and [101-110]
incremental changes of -5% to 5% (Read/Write). For example, to set the light level to an absolute percentage, such as 40%, write a value of 40 to the MSV's present

value. To change the light level in a relative fashion, for instance to decrement the light level by 3%, write a value of 103 to the MSV's present value.

5. Night Light Enabled configures a station to have its indicator LEDs emit a soft light when the LED would otherwise represent a logical off. The light is less bright than when the LED indicator is on, but still sufficient
to help find the station in an otherwise darkened space. This feature is useful for illuminating the station in low light situations.

6. Save and send settings.

CANbus Notifications
Notification of CANbus issues are available to aid in operation and diagnostics of Stations for all but Version 1 station models.




1. Loss of CANbus communication will result in all LEDs on the
Station repeatedly flashing three times quickly followed by a short pause. This will indicate that the CANbus has accumulated enough errors to consider
the CANbus to be unusable. Once enough messages have been successfully sent, the errors will be cleared and the three blinks will stop. There are a few conditions that may cause this to happen.

>
The End-of-Lines are not terminated and causing the communications to fail.
There could be a loose wiring connection to the Station.
There may be a short in the communication cable.

2. If the Station does not receive communication from the Control Module, all of the LEDs on the station will flash two times quickly followed by a pause and then repeat the pattern. There are a few things that may
cause this blinking to happen.

>
The Control Module may not be powered on.
The Control Module may not be wired correctly to the CANbus.
If the Control Module is running firmware version older than 3.0.0 and its system settings tell it not to expect any devices on the CANbus, it will not be attempt any communication on the CANbus, including a 'heartbeat' message.
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Zone: Control Module Assignment
Blue Ridge Technologies® | Essentials Help

Overview

Control Module Assignment establishes a zone's relationship
with a control module and BACnet client.

What do you want to do?
Assign a Control Module to a Zone

Assign a Control Module to a Zone

1. Choose a control module by name. This establishes the relationship between the control module and the zone it controls. Selecting a control module will make this zone 'live' on that control module.

Attempts to change this binding after channels are added to the zone will result in a warning and the loss of those channels if proceeeded with.

2. Save and send settings.
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Zone: Run Command
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Overview

Run Command offers an option for exposing the Zone's Run Command as a commandable BACnet Binary Value (BV) Point. And if exposed, controlling the point from Essentials.

What do you want to do?
Expose a Zone's Run Command for BACnet Client Discovery
Control a Zone's Exposed Run Command

Expose a Zone's Run Command for BACnet Client Discovery

1. Select the BACnet checkbox.

2. Save and send settings.

Control a Zone's Exposed Run Command

If the Run Command has been exposed on BACnet, and Essentials is connected to the system, then the above additional interface will appear. It displays the current present value of the Binary
Value (BV), as well as the contents of its priority array and its relinquish default property. Additionally, an operator can alter the present value from Essentials by selecting a value and a priority and
pressing send.
Priorities 1 through 16 can be written with the values 0 (OFF), 1 (ON), or NULL. The relinquish default, a special 'backstop' property, can be written to with only 0 (OFF) or 1 (ON). NULL is not
permitted for this property. This ensures that the present value always has a definite, non-NULL value.

Every time the priority array is written to, the present value is recalculated as follows:
Starting with priority 1, the highest priority, and moving left to right, take the first non-NULL value encountered
and make it the present value. If all priorities are NULL, as in the above graphic, then the value of the relinquish default is used.

Since non-NULL values at higher priorities will 'block' or take precedence over lower priorities, it is considered a BACnet 'best practice' to use the lowest priorities available to accomplish a desired
behavior. This leaves the maximum headroom for any future design changes that might need to utilize additional priorities. In practice, we suggest using priority 16 in most cases unless there is a
compelling need otherwise.

This live view will reflect changes made by another agent altering the point from a front-end BACnet point reader/writer while under observation by Essentials.
Finally, we note a special quality of the Run Command point that is a proprietary extension of its BACnet qualites. If any of the channels in the zone have chosen remote with local schedule fallback
(see the Occupied Mode/Unoccupied Mode section) as their mode source, then the run command gains a timer associated with it, counting down from the last time the run command was written to.
Any write to the run command tops up and restarts the countdown on this fallback timer. Any write will do, even ones that do not substanitively change the point's present value from its value prior to
the write.
Examples of this strategy where the PV doesn't change due to a write could include writing NULL repeatedly at a priority higher than the highest non-NULL priority. e.g. writing NULL to priority 15
while doing the substantive changes of writing 1's and 0's at priority 16. 

Alternatively, one might write the current desired present value repeatedly at the same priority at timed intervals, e.g. writing a 1 every four minutes at priority 16. In both cases, the present value itself
is unchanged after the re-evaluation prompted by the write. Crucially though, the fallback timer has been topped up.
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Zone: Schedule
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Overview
In Essentials, zones can be configured to run on a schedule that determines when lights should be on or off. Schedules can allow for any combination of times within the week, and exceptions can be
added to account for any specific day or time frame that a zone may be unoccupied on a less than regular basis. For additional information on local Schedule implementation see the Occupied
Mode/Unoccupied Mode section.

What do you want to do?
Configure a Zone's Schedule
Expose a Zone's Schedule for BACnet Client Discovery

Configure a Zone's Schedule

1. To configure a weekly schedule select a
day, add a transition, select a time, and select a transition
action (ON/OFF). A maximum of twelve transitions may be specified per
day. Please note on days when no
transition occurs, the local schedule will default to unoccupied.

 A midnight crossing of ON will require an
ON to be sent the next morning at 12:00 AM to remain ON.

2. To create an exception, add an exception,
add a transition, select a time, select a transition action
(ON/OFF), and select one of the exception types listed below. A maximum of four exceptions with 6 transitions
per
exception may be specified.

On : Exception occurs on specified date.
Beginning : Exception applies between
specified beginning and ending dates.
In : Exception occurrence is specified by
selecting a month and selection of days within that month.

3. Save and send settings.

Expose Schedule for BACnet Client Discovery

1. Check the BACnet checkbox.

2. Save and send settings.

Note: exposure of the local schedule over BACnet is not neccessary for the zone and its channels to be driven by the schedule. It is just another means to view and edit the schedule, albeit via
BACnet.
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Zone: Fallback Timer Duration
Blue Ridge Technologies® | Essentials Help

Overview

Fallback Timer Duration sets the length of time that needs to elapse after a write to a zone's run command, after which the local schedule will become the operative mode source for channels using the
remote with local schedule fallback strategy.

What do you want to do?
Set the Schedule Fallback Timer Duration

Schedule Fallback Timer Duration

1. Type or adjust the spinners for the desired value of the fallback timer. The range is from 1 minute to 1 week (10,080 minutes.) The default is 2 minutes.

2. Save and send settings.

With this setting, any of the zone's channels which have chosen remote with local schedule fallback strategy (see the Occupied Mode/Unoccupied Mode section) as their mode source will be rely on this
timer to determine a fallback condition.

This timer is topped up any time the zone's run command is written to, whether or not the write substantively changes the present value from what it was prior to the write. If no write is logged for the
timer's duration, then the channel(s) under the fallback strategy will thereafter have their mode determined by the zone's schedule. However, any subsequent write to the run command will revert
mode control back to the run command and restart the timer. Often this strategy might be employed as a redundancy measure where there is a concern about run command updates being issued in
a timely manner.
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Zone: Channels and BACnet
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Overview
A Channel section is created for each channel within a zone. Settings in this section enable the status (OFF/ON) and level (%) of the channel to be read by the BACnet client.

What do you want to do?
Expose Channel Status for BACnet Client Discovery
Expose Channel Level for BACnet Client Discovery

Expose Channel Status for BACnet Client Discovery

1. Check the BACnet checkbox. The channel status is available for exposure for all channels. It is a read-only BV, with values 0/OFF and 1/ON.

2. Save and send settings.

Expose Channel Level for BACnet Client Discovery

1. Check the BACnet checkbox. The channel level will appear available for exposure only for those channels which have one or more Analog Outputs. It is a read-only AV, with values in whole numbers between 0
and 100 percent.

2. Save and send settings.
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Channel: Channel Status and BACnet
Blue Ridge Technologies® | Essentials Help

Overview
A Channel Status subsection is at the top each channel's detail pane. Settings in this section enable the status (OFF/ON) and level (%) of the channel to be read by the BACnet client. Furthermore,
when connected to a system the status and attribution of the channel's condition will be displayed

What do you want to do?
Expose Channel Status for BACnet Client Discovery
Expose Channel Level for BACnet Client Discovery

Expose Channel Status for BACnet Client Discovery

1. Check the BACnet checkbox. The channel status is available for exposure for all channels. It is a read-only BV, with values 0/OFF and 1/ON.

2. Save and send settings.

Expose Channel Level for BACnet Client Discovery

1. Check the BACnet checkbox. The channel level will appear available for exposure only for those channels which have one or more Analog Outputs. It is a read-only AV, with values in whole numbers between 0
and 100 percent.

2. Save and send settings.
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Channel: Switches and Stations
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Overview
Switches and Stations assigns switch and station buttons control of the channel, defines presets, and enables button lockout.

What do you want to do?
Assign Switches
Assign Stations
Configure Button Lockout

Assign Switches
To assign a switch to the channel begin by adding a switch with the Add button. Then select a switch type and switch input. The available switch type options are determined by the Universal Input
and Line Voltage Input configuration. There are three possible switch types:

Switch ON/OFF

Universal Input : This menu is populated with universal inputs configured as momentary ON/OFF, maintained, and change of state in the Universal Inputs section. Select a universal input to assign the switch to the
channel.
Switch ON Switch OFF

'ON' Universal Input and 'OFF' Universal Input : These menus are populated with universal inputs configured as momentary ON and momentary OFF in the Universal Inputs section. Select a universal input of each type
to assign the switch to the channel. Note that both a momentary on and a momentary off switch must be designated in the Universal Inputs to have this option available.

Line Voltage Switch

Line Voltage Input : Select a Line Voltage Input to assign the switch to the channel.

Assign Stations
To assign a station to the channel begin by adding a station with the Add button. Then select a station type. Station type options are derived from the Station: General Settings and station position on
the Physical Tree. There are three possible station types.

ON/OFF

Station : Select the desired station from within the station type. station names follow this format: Physical Tree Station Name - (Address)

Button: Select the desired button from the station to assign it to the channel. Buttons are identified according to their location on the station (top, bottom, middle left, bottom right, etc.). Depending on station type, a
single button (only) or multiple buttons may be available.

Raise/Lower

Station : Select the desired station from within the station type. Station names follow this format: Physical Tree Station Name - (Address)

Button Set : Select the desired button set from the station to assign it to the channel. Button sets have three options depending on station type, a single button set (Only) or button set left or right.

Preset

Station : Select the desired Station from within the station type. Station names follow this format: Physical Tree Station Name - (Address)

Button: Select the desired button from the station to assign it to the channel. Buttons are identified according to their location on the station (top, bottom, middle left, bottom right, etc.). Depending on station type, a
single button (only) or multiple buttons may be available.

Preset : Preset configuration is composed of three components:
Command Channel : Select an action for the Preset button (ON/OFF).

Level : If the Preset commands the channel ON, select the desired light level. This is expressed as a percentage of light output established in the Analog Output Assignment.

Transition : Enable this setting to control the transition from current level to preset level upon button press. If transition is disabled the level will change instantly.
Fade Time : This regulates the transition period (1-30 seconds) until preset level is reached.



Ramp Rate : This governs the transition in percent change per second (1-100%).

Configure Button Lockout

Button Lockout: This allows switches and individual Station button functions to be disabled, either in a specific Mode or via a Maintained Input. Raise and lower functions cannot be locked out.

Button Lockout may be initiated by schedule (i.e. the Mode changes to Occupied or Unoccupied invoking the Mode based policy) or Maintained Input.

Schedule implementation allows a unique button lockout strategy for both Occupied and Unoccupied mode respectively. This is suited for public corridors, restrooms, and other applications that require limited
occupant control of lighting.

Maintained Input based locking allows for the suppression of switch or button functions when the Maintained Input is ON.
There are three options for Button Lockout:

1. Disable ON functionality only.
2. Disable OFF functionality only.
3. Disable both ON and OFF functionality.

Note in the Maintained Input case, the option choices are greyed out until a concrete Maintained Input has been selected, as it would not be applicable otherwise.
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Channel: Relay Assignment
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Overview
Relay Assignment establishes a relay output's relationship with the channel.

What do you want to do?
Add or Delete a Relay
Interpret Relay Information

Add or Delete a Relay

1. To add a relay, click the Add button. This automatically adds the next available relay.

2. Select a relay output to assign it to the current channel using the Relay Output drop down box.

3. To delete a relay, select the checkbox next to the appropriate relay and then click Delete. This allows for the removal of multiple unwanted relays from a channel at a time.

4. Save and send settings.

Interpret Relay Information
Each relay row in the channel subsection includes several columns of additional helpful information.

When connected to a system the last commanded-to value of the relay is displayed.

When connected to a system, and if the relay supports load status, the sensed load status of the relay is displayed.

The name of the module on the physical tree from where the relay was sourced is displayed. Click on the name label to be taken to the detail panel of that module.
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Channel: Digital Output Assignment
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Overview
Digital Output Assignment establishes a digital output's relationship with the channel.

What do you want to do?
Add or Delete a Digital Output
Interpret Digital Output Information

Add or Delete a Digital Output

1. To add a digital output, click the Add button. This automatically adds the next available digital output. An output must be added before beginning configuration.

2. Select a digital output to assign it to the current channel using the Digital Output drop down box.

3. To delete a digital output assignment, select the checkbox next to the appropriate digital output and then click Delete. This allows for the removal of multiple unwanted digital outputs from a channel at a time.

4. Save and send settings.

Interpret Digital Output Information
Each relay row in the channel subsection includes several columns of additional helpful information.

When connected to a system the last commanded-to value of the digital output is displayed.

The name of the module on the physical tree from where the digital output was sourced is displayed. Click on the name label to be taken to the detail panel of that module.
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Channel: Analog Output Assignment
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Overview
Analog Output Assignment establishes an analog output's relationship to the channel and enables configuration of trim limits. Trim limits allow the user to set a minimum and maximum light output
amount, which is useful for lumen maintenance or to prevent a fixture from dimming fully to off. These settings apply to dimming model controllers only.

What do you want to do?
Add or Delete an Analog Output
Interpret Analog Output Information
Adjust the Trim Level
Expose the Trim Levels for BACnet Clients

Add or Delete an Analog Output

1. To add an analog output, click the Add button. This automatically adds the next available analog output.
An output must be added before beginning configuration.

2. Select an analog output to assign it to the
current channel using the Analog Output drop down box.

3. To delete an analog output, select the checkbox next to the
appropriate analog output and then click Delete. This allows for the removal of multiple unwanted analog outputs from a channel at a time.

4. Save and send settings.

Interpret Analog Output Information
Each analog output row in the channel subsection includes two columns of additional helpful information.

When connected to a system the last commanded-to value of the analog output is displayed.

Additionally, the name of the module on the physical tree from where the analog output was sourced is displayed. Click on the name label to be taken to the detail panel of that module.

Adjust the Trim Level

1. Adjust the trim limits using Low Trim and High Trim. Ideal for lumen maintenance control strategies, trim limits restrict the range of the analog output. Limits are expressed as a percentage (0-100%) of the output's voltage
range established in the Analog Outputs section.

2. Save and send settings.

Expose the Trim Levels for BACnet Clients

This setting is used to enable two Multi-state Value (MSV) BACnet points that correspond to the Analog Output's Trim Level percents displayed immediately to the left of these settings in the same row. 

The MSV point starting with 150 sets the percentage for the Low Trim.

The MSV point starting with 151 sets the percentage for the High Trim.


These MSVs have 101 states. Each state corresponds to a percent, from 0 to 100 inclusive. So 1 = "1Pct", 2 = "2Pct", etc.. Of note: MSVs do not accept 0 as a legal value, so "0Pct" is achieved with the value
101.
A point's present value determines the Trim Level for the AO. The Analog Output will be unable to cross that floor or ceiling if the channel level percentage passes it.


Enabling this pair of points via send settings will also place the choices in the AO Trim Level cells to the left of this setting at priority 16 of the corresponding BACnet point's priority array for the purposes of
computing the point's present value. Any subsequent send settings will re-establish the values set in the AO Trim Level cells and clear out any non-NULL values that have been entered elsewhere in the priority
array.

1. Check the Visible Via BACnet checkbox.

2. Save and send settings.
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Channel: DMX Device Assignment
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Overview
DMX Device Assignment provides configuration of BRT Lighting Channel settings. When the Control Module has been set to DMX512 Transmit mode, the behavior of any DMX channels found on
DMX RX Devices that are children of the Control Module assigned to the Zone in which this Lighting Channel resides can be configured. Alternatively, if the Control Module has been set to DMX512
Receive mode, the Lighting Channel can be configured to be controlled by a transmitting remote DMX device.

What do you want to do?
Control Module as DMX TX Device - Lighting Channel Configuration
Control Module as DMX RX Device - Lighting Channel Configuration

Control Module as DMX TX Device - Lighting Channel Configuration

1. If the Zone's assigned Control Module is DMX capable and Transmit has been selected as the DMX512 Mode in the Control Module's General Settings, then the DMX Device Assignment for TX will appear in the
Channel's subsection listings.

2. Press the Add button to append one of the Control Module's child DMX RX
devices to the channel's outputs. Use the Combo Box Menu to select amongst the available DMX RX devices.

3. Each added DMX RX device provides configuration options for how it will perform within the Lighting Channel.

For each DMX channel on each DMX RX device there is a configurable "Value at 100% Level" field. This represents the value, from 0-255, that
will be transmitted on that DMX channel when the Lighting Channel's
level is
at 100%. This can be thought of as a scale factor. For instance, if one enters 255 here, then when the channel level is at 50% the corresponding DMX channel will be transmitting 128 (and similarly, 64 at
25%, and 192 at 75%.) If zero is chosen then the DMX channel will remain "Off" no matter the Channel Level %. In general, the DMX channel value will is given by rounding the following calculation to the nearest
whole number: ("Value at 100% Level" × "Channel Level %") ÷ 100.

4. Across the top of each DMX RX Device Lighting Channel configuration there is a row of three demand response setting percentages. These are applicable only if Demand Response has been enabled for the
enclosing Lighting Channel. These percentages are the ceiling of the Channel Level % that the DMX RX device is capped at should that Demand Response Level for energy savings be enagaged. The particluar
DMX channel values that the DMX RX device's DMX channels would be commanded to in this instance are still governed by the scale factor set on each DMX channel's "Value at 100% Level" field. For example, if
Level 3 Demand response was set to 90% and the DMX Channel 1, Red, was still set to 255 for "Value at 100% Level", when Level 3 demand repsonse is enganged, it would limit the DMX from ever rising above
DMX value given at 90% which is 230 ≅ (255 × 90) ÷ 100. For Channel Level percentages from 0% to 90% the DMX channel would still track the same as the example given in Step 3.

5. A final example, in the above screenshot the Red and Blue channels have been set to track out the full range of DMX channel values as the Channel Level tracks from 0% to 100%. Meanwhile, the Green DMX
channel will transmit zero no matter what. In practice, this hyptoectical DMX RX device will emit a consistent purple color, growing in luminosity as the channel level rises.

6. When all DMX channels added to the channel are configured as desired along with their RX devices' Demand Response settings (if applicable), then save and send settings.

Control Module as DMX RX Device - Lighting Channel Configuration

1. If the Zone's assigned Control Module is DMX capable and Receive has been selected as the DMX512 Mode in the Control Module's General Settings, then the DMX Device Assignment for RX will appear in the
Channel's subsection listings.

2. Configure the DMX Base Address field. The value chosen will be the start of a three DMX channel interval that dictates how this Lighting Channel is driven from the transmitting DMX device to which the Control
Module is linked.

3. Starting with the base address, the channel will be commanded over DMX as follows:



Base address: Determines whether DMX should be controlling this channel at all presently. Think of this channel as a control wire. DMX Value 0 = Channel not controlled by DMX, i.e. free to be driven by other
inputs such as a Station; DMX Value 1-255 = Channel controlled by DMX.

(This is necessary because under the hood the DMX protocol is a continuously repeated transmission of the values for each channel in the DMX universe. If this 'control wire channel' was not present, then from an
event driven perspective it would impossible to have a channel driven by anything other than DMX exclusively. The DMX channel status and level values would appear to be re-asserting continuously, superseding
any contradictory settings registered from button presses from a Station input.) When this DMX channel is 0, the values of the next two DMX channel addresses are ignored by the Lighting Channel.



Base address + 1: Controls the Channel On/Off Status as follows: DMX Value 0 = Channel OFF; DMX Value 1-255 = Channel ON.






Base address + 2: Controls the Channel Level % as scaled from the range of 0-255 to the level % of 0-100. More specifically, the received DMX channel value is converted to Channel Level % as follows ("RXed
DMX value" ÷ 255) × 100.

4. Save and send settings.
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Channel: Occupied / Unoccupied Mode
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Overview
These settings regulate channel operation with regards to the Mode. The Mode is determined by the present value of either the Zone's Run Command or Schedule. The present value of those maps to the following
interpretation:

Occupied Mode (Run Command/Schedule = Active/1) or Unoccupied Mode (Run Command/Schedule = Inactive/0).

Occupied Mode is the period during which people are expected to be in the building.

Unoccupied Mode is the period during which people are not expected to be in the building.

Take care not to confuse Schedule or Run Command based control with sensed occupancy. Sensed occupancy is when a channel's occupancy condition can be determined to be either occupied or unoccupied based
off of an occupancy sensor, with the lights in the room configured to operate accordingly. See Occupancy Sensors for specifics on how to configure channel occupancy.

What do you want to do?
Configure Mode Source
Configure Transition to Occupied Mode
Configure Occupied Timer
Off Light Level-Occupied
Transition to Unoccupied Mode
Configure Unoccupied Timer
Off Light Level-Unoccupied
Lights Off Warning: Blink Lights and Blink Station Indicators

Configure Mode Source

1. Select one of the following mode control sources:
Remote Command : A write command from a BACnet client to the Run Command BACnet point will set the Occupied / Unoccupied Mode. See Run Command for specifics on the required BACnet client configuration.
Local Schedule : A BACnet Schedule object belonging to the containing Zone, residing on the control module, and informed by the onboard time and date, will set the Occupied / Unoccupied Mode. The schedule itself is optionally
editable via BACNet as well as Essentials. See Schedule Settings for specifics on the required configuration.
Remote with Local Schedule Fallback : A command from a BACnet client to the Run Command will set the Occupied / Unoccupied Mode. If a refresh of this command is not received within the duration of the fallback timer, then the
local Schedule object as informed by the onboard time and date will set the mode. See Run Command and Schedule Settings for specifics on the required BACnet client configuration.

2. Select the BACnet point checkbox to expose a BACnet Multi-state Value (MSV) representing the channel's mode source to the BACnet client as a writable point. This allows configuration of the mode source via
BACnet. Possible values to read/write are [0] Remote, [1] Local Schedule, and [2] Remote with Local Schedule Fallback.

3. Save and send settings.

Configure Transition to Occupied Mode

1. Select a setting for Transition to Occupied. This governs the channel's transition from Unoccupied Mode to Occupied Mode. There are two possible settings for Transition to Occupied:
Manual ON : When transition occurs, the channel assumes Occupied timer values but will require another input to transition to ON.

Auto ON : When transition occurs, the channel assumes Occupied timer values and comes ON automatically.

2. Save and send settings.

Configure Occupied Timer

1. Select the Occupied Timer checkbox. This option establishes a period (1-1440 minutes, up to 24 hours) during which the channel will remain ON after an occupant uses a switch/station to command the channel, or
when the channel has come ON via an Auto On transition from Unoccupied mode to Occupied Mode. Default is 60 minutes. If the timer is not enabled, the channel remains ON indefinitely in Occupied until another
event turns it OFF.

2. Select the BACnet point checkbox if applicable. This exposes a BACnet Analog Value (AV) representing the Occupied Timer setting to the BACnet client. Possible values to read/write are [1-1440] minutes.

3. Save and send settings.

Off Light Level-Occupied

1. Select the Off Light Level checkbox. This makes a channel command of OFF only set the lights to the designated % level instead of turning the relay(s) off. This can be used in areas where a certain minimum light
level is required throughout occupied mode, such as emergency lighting, but when no one is present it can be lower than usual. When a channel command of ON is invoked, the level will return to the normal ON



operation for that mode. The default is 0%.

2. If the Off Light Level enable checkbox has been selected, then an additonal checkbox becomes selectable. The rightmost checkbox offers the option to enable the Off Light Level percentage as a commandable
MSV BACnet point. The point's default is 0% and offers whole number percentage choices from 0% to 100% inclusive.

3. Save and send settings.

This setting is similar to the "When Vacant" setting of Occupancy Sensor, except no occupancy sensor is required for this. Instead, a switch can be used to turn the channel OFF, which will just set the lights to a lower
level.

Transition to Unoccupied Mode
A transition to Unoccupied Mode will turn OFF the channel or begin the blink warning if it is enabled, except for one condition. If an occupancy sensor is active, signaling an occupant, the channel will remain ON.

Configure Unoccupied Timer

1. Select the Unoccupied Timer checkbox. This option establishes a period (1-1440 minutes, up to 24 hours) during which the channel will remain ON after an occupant uses a switch/station to command the channel.
Default is 60 minutes. If the timer is not enabled, the channel remains ON indefinitely in Unoccupied until another event turns it OFF.

2. Select the BACnet point checkbox if applicable. This exposes a BACnet Analog Value (AV) representing the Occupied Timer setting to the BACnet client. Possible values to read/write are [1-1440] minutes.

3. Save and send settings.

Off Light Level-Unoccupied

1. Select the Off Light Level checkbox. This makes a channel command of OFF only set the lights to the designated % level instead of turning the relay(s) off. This can be used in areas where a certain minimum light
level is required throughout unoccupied mode, such as emergency lighting, but when no one is present it can be lower than usual. When a channel command of ON is invoked, the level will return to the normal ON
operation for that mode. The default is 0%.

2. If the Off Light Level enable checkbox has been selected, then an additonal checkbox becomes selectable. The rightmost checkbox offers the option to enable the Off Light Level percentage as a commandable
MSV BACnet point for unoccupied mode. The point's default is 0% and offers whole number percentage choices from 0% to 100% inclusive.

3. Save and send settings.

This setting is similar to the "When Vacant" setting of Occupancy Sensor, except no occupancy sensor is required for this. Instead, a switch can be used to turn the channel OFF, which will just set the lights to a lower
level.

Lights Off Warning: Blink Lights and Blink Station Indicators

1. Select the Blink Lights and/or Blink Station Indicators checkboxes to enable blink alerts to the occupant about the channel going OFF imminently. This can arise out of three situations:
First, if the Override Timer has completed its countdown while in the current Mode in which it has been enabled.
Second, if the channel is ON in Occupied mode and has an impending transition to Unoccupied Mode upon which the channel will go OFF.

Third, if the Channel is ON in Unoccupied mode and has an impending transition to Occupied Mode and the transition policy is Manual On.

The blink settings begin their execution at the time of the transition. The timer in this section appends itself after the relevant OFF-producing event has occurred or timer has expired. Take note that the lights then
remain on for an additional time after the blink settings execute. The remain on timer ranges from 1 to 60 minutes, with a default of 5 minutes. The blink options are composed of two components:

Blink Lights: Blinks lights once prior to mode transition or occupied/unoccupied timer expiration.
Blink Station Indicators: Blinks station indicators continuously at mode transition or occupied/unoccupied timer expiration.

2. Save and send settings.
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Channel: Occupancy Sensor
Blue Ridge Technologies® | Essentials Help

Overview
Occupancy Sensors provide occupant detection for all unified lighting control platforms, using passive infrared technology or a combination of passive infrared and noise detection technology. They
can be used to control the lights within that room or zone accordingly. Sensors can be assigned to channels and regulate them based on the sensors' status of occupied or unoccupied.

What do you want to do?
Configure Sensor Input
Configure Occupied/Unoccupied Mode
Establish Grace Period

Configure Sensor Input

1. Select a Sensor Input to assign the sensor to the channel. Up to eight sensors may be added to a single channel. This menu is populated with Universal Inputs configured as occupancy sensors in the Universal
Input section, including ones defined as global from other controllers. The checkbox is used to select sensors for deletion from the channel.

2. Save and send settings.

Configure Occupied/Unoccupied Mode

1. Select Manual On to prevent this channel from coming on automatically when occupancy is detected. This is typically referred to as a Vacancy Sensor.

2. Select Auto On to set this channel to come on automatically when occupancy is detected.

3. Select Early Off if applicable. When activated, if the occupancy sensor timeout is in progress due to vacancy and a transition to Unoccupied Mode occurs, the Timeout will be cancelled and the channel will turn
OFF. Refer to Occupied Mode / Unoccupied Mode for more information.

4. Set a Timeout period. When vacancy is detected, timeout is the period (1-240 minutes) until the channel turns OFF. Default is 30 minutes.

5. Select the BACnet checkbox if applicable to expose a BACnet Analog Value (AV) representing occupancy sensing's timeout setting to the BACnet client. Possible values to read/write are [1-240].

6. Select the Once Vacated checkbox if applicable. When enabled, if the occupancy sensor detects vacancy for the designated duration (1-240 minutes), the channel will dim to the designated light level (1-100%).
Defaults are 15 minutes and 50%.

7. Select the then Timeout checkbox if applicable. When then Timeout is enabled, once the channel has dimmed to the designated light level, the occupancy sensor timeout will begin and turn the channel OFF upon
expiration. If this is not selected, the light will remain ON until a transition to Unoccupied occurs, or a switch is used to turn the light off.

8. Save and send settings.

Establish Grace Period

1. Select Grace Period if applicable. When enabled, the occupant has a designated period (1-60 minutes) after the channel turns OFF due to vacancy detection to make a motion to re-establish sensed occupancy
and turn the channel back ON automatically. This is only available when Manual mode is selected. It is not applicable in Auto mode, as the channel would turn back ON automatically upon sensed occupancy. The
default is 1 minute.

2. Save and send settings.
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Channel: Daylight Harvesting
Blue Ridge Technologies® | Essentials Help

Overview
Daylight harvesting adjusts the fixture light level in response
to changes in the daylight level. This achieves energy savings by
decreasing the artificial light level as the daylight level
increases. There
are two daylight harvesting strategies from which to choose:

1. Closed Loop : The total light level, both daylight and artificial, is sensed, and the controller continually adjusts the channel's level to maintain total light at a user defined setpoint.
2. Open Loop : The daylight level is sensed and the controller adjusts the channel level in proportion. The daylight to channel level proportion is calculated according to a user defined setpoint and daylight at 100%

value.

Additionally, there are two set-point modes from which to choose:
1. Comfort Based Setpoint : While the channel is ON, the occupant sets a channel level with an up or down adjustment on a raise/lower station. Once the occupant defines a channel level, a reading from the

assigned light sensor input is taken. For closed loop strategies, a total light level reading is stored as the light level to maintain. For open loop strategies, the channel level and a daylight level reading are employed
by the controller to calculate the daylight to channel level proportion.

2. Fixed Setpoint : The building operator writes a channel level from a BACnet client to the BACnet analog value (AV) that defines the fixed setpoint. For closed loop strategies, the setpoint is stored as the light level
to maintain. For open loop strategies, the channel level and a daylight level reading are employed by the controller to calculate the daylight to channel level proportion. The Fixed Setpoint may also be used as an
initial setpoint until an installation is finished with Raise/Lower stations.

Finally, a setpoint tolerance may be defined. While the channel is ON, the controller will adjust the channel level so that it is within the tolerance.

What do you want to do?
Enable in Occupied/Unoccupied Mode
Configure Closed Loop Daylight Harvesting
Configure Open Loop Daylight Harvesting
Determining Settings for a Room

Enable in Occupied/Unoccupied Mode

1. Select the In Occupied Mode and/or In Unoccupied Mode checkboxes to enable Daylight Harvesting in either Occupied or Unoccupied Mode or both. See Occupied Mode / Unoccupied Mode for reference to these
modes.

2. Save and send settings.

Configure Closed Loop Daylight Harvesting

1. Select the desired light sensor input from the drop-down list. If the desired input is missing from the list, go to Universal Inputs to configure it.

2. Select the Closed Loop radio button.

3. Configure the Setpoint in the editor. The Setpoint is used to guide the channel to a level where the combined total of sensed natural and artifical light will be nearly equal to the setpoint.

A Fixed Setpoint is used when there is no Raise/Lower station assigned to the channel. The Fixed Setpoint will be set initially in Essentials, and then can be optionally maintained through BACnet.

A Comfort Based Setpoint in contrast, will be set initially by Essentails but thereafter by the use of a Raise/Lower station. For information on Station assignments, see Channel:
Switches and Stations. If setpoint
maintenance over BACnet is desired, click the checkbox to enabled a writable BACnet AV point.

The units for the setpoint are determined by those chosen for UI light sensor, either foot candles (fc) or lux (lx). The setpoint's range is equal to what has been configured for light sensor in UI settings, and the
default setting is the light sensor's minimum reading.

4. Enable and set the Channel Off Level percentage if desired. Channel Off Level is an additional energy saving daylight harvesting feature that works as follows. If the channel level is driven to a level at or below the
Channel Off Level percentage while endeavoring to guide the light sensor reading to the setpoint, the channel's lights are shut off. Later, if the light sensor reads below the setpoint, the channel level is moved
upward from the Channel Off Level and the channel's lights are turned back on.

To further clarify, the energy savings in this feature are achieved by cutting the power to the AOs by turning off the ROs supplying them.
During this condition, the Channel Status will still read ON, and the Channel
Level will be set at the Channel Off Level percentage.
Conversely, when daylight haresting dictates that the channel level move back above Channel Off Level floor, the ROs are turned back ON, resupplying the
AOs.

5. Adjust the daylight harvesting parameters. The ramp rate, ramp period, and affordance percentage can be used to tune daylight harvesting behavior to one's preference. The first two parameters, with defaults of
1% and 10 seconds respectively, determine how quickly the artificial light level changes in response to a change in sensed light level. The third parameter is the affordance percentage, both above and below the
setpoint, where daylight harvesting may cease adjusting the artificial light level once 'close enough' to the setpoint in percentage terms. The default is 10%. These default values have been found to be effective for
most operations; avoiding jarring large light changes for the occupants, while still achieving energy savings. Finally, all three of these tuning parameters may be enabled as BACnet points which allows for their
further maintenance over BACnet.

6. Save and send settings.

Configure Open Loop Daylight Harvesting



1. Select the desired light sensor input from the drop-down list. If the desired input is missing from the list, go to Universal Inputs to configure it.

2. Select the Open Loop radio button.

3. Configure the Setpoint and the Daylight at 100% fields in the editor.
Together these comprise the horizontal components of two points on a line along which the channel level will be adjusted based on the light
sensor's reading.

The line graph below uses the values from the configuration above. The x-axis is the light sensor reading in fc, while the y-axis is the channel level %. The graph is a concrete example to help develop an intuiton
about the behavior and configuration of Open Loop daylight harvesting.
Daylight at 100% should be set to the highest daylight/natural-light level, as read by the light sensor, at which the occupant would like the channel level to maintain 100% output.
Stated differently, any reading less
than the Daylight at 100% value would also dictate a channel level of 100%. In the graph below, this implies that to the left of the y-axis the line continues, but now as a flat line at channel level 100% for fc readings
between 75 and 0.

Put yet one other way, and as offered below in Determining Settings for a Room-Open Loop Daylight at 100% determination this will often be the sensor reading one gets when it is still dark outside and the channel
level is dimmed up to 100%.

Setpoint on the other hand should be set to the daylight/natural-light level, as read by the light sensor, at which the occupant would like the channel level to be at 0% output. Stated differently, any reading equal or
greater than the Setpoint value would also imply channel level of 0%. In the graph below, this implies that in the unseen continuation of the graph along the x-axis the line continues, but now as a flat line at channel
level 0% for fc readings from 300 and up to the sensor's maximum.

As one can see, the line is always going to have a negative, or declining, slope. The greater the difference between the Daylight at 100% and the larger Setpoint value, the slower the channel lights will dim as the
contribution of natural light to the sensor reading increases.



The first of the two points used to define the line is thus at (75fc, 100%).

The second of the two points used to define the line is thus at (300fc, 0%).




4. Adjust the daylight harvesting parameters. The ramp rate, ramp period, and affordance percentage can be used to tune daylight harvesting behavior to one's preference. The first two parameters, with defaults of
1% and 10 seconds respectively, determine how quickly the artificial light level changes in response to a change in sensed light level. The third parameter is the affordance percentage, both above and below the
setpoint, where daylight harvesting may cease adjusting the artificial light level once 'close enough' to the setpoint in percentage terms. The default is 10%. These default values have been found to be effective for
most operations; avoiding jarring large light changes for the occupants, while still achieving energy savings. Finally, all three of these tuning parameters may be enabled as BACnet points which allows for their
further adjustment over BACnet.

5. Save and send
settings.

Determining Settings for a Room
To determine settings for a room, the first step would be to check, with no natural daylight, the brightness of the fixtures and set the Trim if needed. The Trim feature of the Analog Outputs limits the
min and max level to which the output may be driven.

Now that the trim is set, if a comfort based (user set) setpoint is used, the setup is complete. The user will use the Raise/Lower station to set their comfort level, and the system will maintain the level.
Setpoint determination—Closed Loop
A Fixed Setpoint in a system is used when there is not a Raise/Lower station within the room.

This may be set at the same time as setting the trim, described above. To find the setpoint this way, once the trim value is found for full output, use the reading of the light sensor as the setpoint. This
will maintain the lights at the full Trimmed level.

Alternatively, if a specific light reading is called out in the specifications, a light meter will be needed to find the setpoint.
1. The light reading should be taken at an appropriate height, such as on a desk, with the meter facing the lights.
2. Dim the lights until the meter reads the specified level.
3. After about 10 seconds, get the reading of the light sensor. This reading will be the setpoint to maintain the correct level of luminosity in the room.

Open Loop Daylight at 100% determination
To find the Daylight at 100% setpoint one must find the point where the natural daylight begins to affect the room. This is best achieved with a light meter.

1. The test should be done in the morning before the natural light begins to affect the room.
2. The light reading should be taken at an appropriate height, such as on a desk, with the meter facing the lights.
3. With the lights set to the full trimmed level, get a reading from the light meter.
4. As the sun rises, watch for a change in the reading from the light meter. A change of 2-3 units should be enough.
5. Get the reading from the room's light sensor, and use this value as the Daylight at 100% value.

Thereafter, as more light filters into the room, the lights will begin to dim to maintain the appropriate level.

Setpoint determination—Open Loop
This is the second component of Open Loop design and will determine how steeply the channel level will dim down as the contribution from natural light increases. This value in light sensor units will
always be greater than the value of Daylight at 100%. The greater the difference, the slower the artificial light will be dimmed as the sensor reading increases.

When the light sensor reads at this setpoint value and above, the lights will be held dimmed to 0%. One should pick the minimum light sensor value for which occupants are be comfortable with only
natural light contributing to the light sensor reading.
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Channel: Light Sensor Control
Blue Ridge Technologies® | Essentials Help

Overview
Light sensors provide the ability to detect a channel's ambient light level. A light sensor may be assigned to a channel to regulate its ON/OFF status based on the defined settings below.

What do you want to do?
Configure Sensor Input
Configure Occupied/Unoccupied Mode

Configure Sensor Input

1. Light Sensor Input : This menu is populated with universal inputs configured as light sensors in the Universal Input section, including those from other controllers that are set to global. Select a sensor input to assign
the sensor to the channel.

2. Save and send settings.

Configure Occupied/Unoccupied Mode

For Light Sensor Control to begin controlling channel behavior, the channel must be turned ON. This can be from a switch, station, schedule, run command, or occupancy sensor (collectively,
occupant interaction.) Once the channel has been turned on, Light Sensor Control will turn the associated lights on and off according to its settings. If occupant interaction is used to turn the channel
OFF, Light Sensor Control will be disabled until the channel is turned back ON.
When enabled, the light sensor assigned to the channel will operate according to the following selected settings:

1. Select the Enable checkbox for the mode(s) that you wish to configure.

2. Using the On Below spinner, establish a level in foot-candles or lux, based on unit configuration in Universal Inputs, at which the lights on the channel will automatically turn ON if the sensed light level falls below the
given threshold. This is useful in a situation such as night time, where the ambient light level on the channel is not sufficient on its own.

3. Using the Off Above spinner, establish a level in foot-candles or lux, based on unit configuration in Universal Inputs, at which the lights in the room or zone will automatically turn OFF if the sensed light level
exceeds the given threshold. This is useful when the daylight in the room or zone is sufficient and the lights in the room are not necessary.

4. The timer establishes a dead-zone in minutes (0-240) during which the channel will remain ON following activation via a switch, station, schedule, run command, or occupancy sensor (collectively, occupant
interaction), regardless of Off Above settings. This is used to prevent the lights from turning directly back off in instances where they are turned on and then immediately exceed the sensor's Off Above threshold. 

The default setting is 0, which itself is a special case. If the channel is activated by occupant interaction, the sensor reading is checked before turning the channel ON. If it exceeds the Off Above setting, then the
channel remains OFF, instead of executing a jarringly rapid on and then off. The channel's status will remain as OFF, attributed to Light Sensor Control. Light Sensor Control remains in force thereafter though. That
is, if the sensor value subsequently drops below the On Below theshold, the channel will go ON.

5. Save and send settings.
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Channel: Demand Response
Blue Ridge Technologies® | Essentials Help

Overview
Demand Response provides the tools to adminster energy consumption behavior via Essentials or a BACnet front end.
Blue Ridge's implementation of Demand Response provides a Multi-state Value
(MSV) BACnet Point to command the Demand Response level of the entire channel. The point itself must be enabled in order to unlock the rest of the channel's Demand response functionality.


The MSV has four possible settings: "Level 1", "Level 2", "Level 3", and "No Level".


"No Level" is the default and indicates Demand Response is not engaged. While "No Level" is engaged the channel will continue to function according to its obligations in other channel sequence
sections.


"Level 1", "Level 2", and "Level 3" are, in escalating order, the stages of Demand Response. Generally, the energy savings are meant to increase with the level, meaning lower ceilings and
suppressed outputs.

What do you want to do?
Expose Demand Response for BACnet Clients
Specify Binary Outputs' Demand Response Behavior
Expose Binary Outputs' Demand Response Behavior for BACnet Clients
Specify Analog Outputs' Demand Response Behavior
Expose Analog Outputs' Demand Response Behavior for BACnet Clients

Expose Demand Response For BACnet Clients

1. Check the Manage Level checkbox.

2. Refer to the Binary Outputs' Behavior section for more information on how the Demand Response level affects Relay and Digital Outputs.

3. Refer to the Analog Outputs' Behavior section for more information on how the Demand Response level affects Analog Outputs.

4. Save and send settings.

Specify Binary Outputs' Demand Response Behavior

These settings specify the ensemble behavior for all binary outputs within a channel. Binary outputs are Relay Outputs and Digital Outputs.


Checking the box in the column for a given level means that when
Demand Response is set to that level, the Binary Outputs will be suppressed. For example, if they were ON and the level is engaged,
they will
be turned OFF. If they were OFF while at that level, attempts to turn them ON by other means, e.g. a Station Button Press, will have no effect on their state.


By convention, as the Demand Response level rises the energy consumption is reduced. That means if the binary outputs are suppressed at a given level, one would expect them to be suppressed at all higher
Demand Response levels as well. That said, it is not expressly forbidden to do otherwise in Essentials or BACnet.


It bears mentioning that the suppression of binary outputs does not affect the channel status seen in BACnet or Essentials' Channel Status sub-panels. Demand Response is an override of a class of
outputs and does not affect the overall status of the containing channel. The binary outputs will return to the status prescribed by the channel upon cessation of Demand Response.

1. Check the box in the Level columns for which the channel should suppress ROs and DOs.

2. Refer to the Binary Outputs' Demand Response Behavior for BACnet Clients section for more information of how the checkbox settings interact with their respective BACnet points.

3. Save and send settings.

Expose Binary Outputs' Demand Response Behavior for BACnet Clients

This setting is used to enable three Binary Value (BV) BACnet points that correspond to the Binary Outputs' Demand Response Behavior found immediately to their left. 

The BV point starting with 321 sets the behavior for "Level 1".

The BV point starting with 322 sets the behavior for "Level 2".

The BV point starting with 323 sets the behavior for "Level 3".


If the BV point's present value is TRUE(1) it is the equivalent of having the corresponding checkbox checked. The channel's binary outputs will be suppressed when that Demand Response level is engaged via
the Demand Response Level MSV.


Enabling this set of points via send settings will also place the choices in the checkboxes to the left of this setting at priority 16 of the corresponding BACnet Point's priority array for the purposes of computing
the point's present value. Any subsequent send settings will re-establish the values represented by the checkboxes (✔ == TRUE; Unchecked == FALSE) and clear out any non-NULL values that have been
entered elsewhere in the priority array.

1. Check the Visible Via BACnet checkbox.

2. Save and send settings.

Specify Analog Outputs' Demand Response Behavior

These settings specify the ensemble behavior for all Analog Outputs within a channel.


Settings the percentage of the cell in the column for a given level means that when Demand Response is set to that level, the Analog Outputs will be limited to that output percantage as a ceiling. For example,
if outputs exceed the ceiling for a level and the level is engaged, they will be dimmed to that level. If they were below that ceiling while at that level, attempts to dim them above that by other means, e.g. a
Station Button Press, will only take them as far as the ceiling.




By convention, as the Demand Response level rises the energy consumption is reduced. That means that if the outputs are ceilinged at a certain percentage for a given level, one would expect the ceiling to be
equal or less at higher Demand Response levels. That said, it is not expressly forbidden to do otherwise in Essentials or BACnet.


It bears mentioning that the ceiling level of analog outputs does not affect the overall channel level seen in BACnet or Essentials' channel status subpanel. Demand Response is overriding the behavior of a
class of outputs and does not change the level the containing channel. The analog outputs will return to the level prescribed by the channel upon cessation of Demand Response.

1. Set the percentage for the ceiling output for AOs in each Level column. The default is 100% i.e. uninhibited operation.

2. Refer to the Analog Outputs' Demand Response Behavior for BACnet Clients section for more information of how the percentage cells interact with their respective BACnet points.

3. Save and send settings.

Expose Analog Outputs' Demand Response Behavior for BACnet Clients

This setting is used to enable three Multi-state Value (MSV) BACnet points that correspond to the Analog Outputs' Demand Response Behavior found immediately to their left. 

The MSV point starting with 321 sets the behavior for "Level 1".

The MSV point starting with 322 sets the behavior for "Level 2".

The MSV point starting with 323 sets the behavior for "Level 3".


These MSVs have 101 states. Each state corresponds to a percent, from 0 to 100 inclusive. So 1 = "1Pct", 2 = "2Pct", etc.. Of note: MSVs do not accept 0 as a legal value, so "0Pct" is achieved with the value
101.
A point's present value determines the ceiling percentage for AOs at that Demand Response level. The channel's Analog Outputs will be limited to that ceiling when the Demand Response level is
engaged via the Demand Response Level MSV.


Enabling this set of points via send settings will also place the choices in the AO Ceiling cells to the left of this setting at priority 16 of the corresponding BACnet point's priority array for the purposes of
computing the point's present value. Any subsequent send settings will re-establish the values set in the AO Ceiling cells and clear out any non-NULL values that have been entered elsewhere in the priority
array.

1. Check the Visible Via BACnet checkbox.

2. Save and send settings.
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Channel: Initial Light Level
Blue Ridge Technologies® | Essentials Help

Overview
Initial Light Level offers settings that determine the output level of a channel after a change to a new mode or upon being turned ON.

What do you want to do?
Set Initial Light Level with Light Level Priority
Set Initial Light Level with Energy Savings Priority

Set Initial Light Level with Light Level Priority

1. If desired, enable the Set initial light level to __% with Light Level priority setting. This setting can be set independently for each of Occupied Mode and Unoccupied Mode. When this setting is enabled, the channel
will always turn ON at the defined initial light level with one exception:

If the channel is turned ON during a Grace Period,the channel will return to the previous level.

2. If desired, check the rightmost checkbox in the row to enable a commandable BV BACnet point. This point will allow for maitenance of the Enable ILL setting (the leftmost checkbox in a row) over BACnet. 1 is
enable, 0 is disable, with 0 being the default, though upon send settings the point's present value will always match that of the Enable ILL checkbox for the row. The ILL priority choice and percentage remain
Essentials-only parameters.

3. Save and send settings.

Set Initial Light Level with Energy Savings Priority

1. If necessary, enable the Set initial light level to __% with Energy Savings setting. This setting can also be set independently for each of Occupied Mode and Unoccupied Mode. When this setting is enabled, the
channel will turn ON at the lower level of either the last light level used before turning OFF or the initial light level chosen here.

2. If desired, check the rightmost checkbox in the row to enable a commandable BV BACnet point. This point will allow for maitenance of the Enable ILL setting (the leftmost checkbox in a row) over BACnet. 1 is
enable, 0 is disable, with 0 being the default, though upon send settings the point's present value will always match that of the Enable ILL checkbox for the row. The ILL priority choice and percentage remain
Essentials-only parameters.

3. Save and send settings.
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Channel: Emergency Override
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Overview
Emergency Override establishes a Maintained Input or BACnet Binary Value point relationship with the channel that will override all other settings. When a channel's emergency override is engaged
the lights will	be commanded to the override settings with all other options being suppressed until the override is disengaged.

What do you want to do?
Select BACnet Override Option
Select Maintained Input Option
Adjust Override Options

Select BACnet Override Option

1. To choose a BACnet Binary Value point as the Emergency Override, select the BACnet radio button. This will expose a BACnet Binary Value (BV) shown to the right for BACnet clients to command.

2. To remove the BACnet point from existence, select the None radio button.

3. Save and send settings.

Select Maintained Input Option

1. To choose a Maintained Input as Emergency Override, click the Input radio button. This will allow the selection of any input that is designated as a Maintained type on the Universal Input or Digital Input sections of Modules on
the Physical Tab.

2. To delete a Maintained Input Emergency Override, select the None radio button.

3. Save and send settings.

Adjust Override Options

1. To have the Emergency Override force the action of all assigned relays and/or digital outputs to On or Off select the check box for this and using the drop down select either On or Off.

2. To have the Emergency Override force all assigned analog outputs to be driven to a given percentage select this the check box, and using the spinner box, enter the value for the desired light level percentage.

3. Save and send settings.
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Overview



The BACnet view can be selected by choosing it in the left columnar panel.

The BACnet view will list all of the points that have been chosen for exposure over BACnet across the entire system.

These points are grouped by Control Module, and further ordered by whether they represent items from the physical tree tab (e.g. I/O, Station buttons), logical tree (e.g. Zone and Channel
properties), and type (e.g. BV, AV, MSV, Schedule, etc.).

The minimum number of points for a given Control Module is 1: the BACnet Device Object representing the Control Module itself, must always be present.

The maximum number varies but can number in the hundreds for a Control Module with many I/O Modules, Stations, Zones, and Channels, where the choice has been made via checkbox to expose
many points of interest.

This view provides provides a helpful consolidated listing of those exposed points, as the very simple example below demonstrates.

In addition to providing a listing of the points within Essentials, the option of exporting to a CSV (comma seperated value) file is available.

This file may in turn be opened in one's preferred spreadsheet viewer (MS Excel, Google Sheets, etc.) or imported to a database.


When the "Export to CSV" button is clicked next to a given device, a CSV file named with the device object's ID number followed by the current timestamp, will be saved to the user's Desktop. The
CSV file contains several additional metadata columns to help sort and identify the points further.

If one checks the "Include unexposed points" box, then when clicking the Export button, in addition to what is seen already in the BACnet tab view, all latent unexposed points will be included in the
generated file. There is an additional column in the exported CSV file denoting whether a given point is exposed or not. For instance, this might include all of the Zones' Schedule objects or various
timers in the Channels that are not enabled by default.


Finally, one may choose "Export All", located at the top of the Panel to the right of the System's name. This action will create a CSV for each of the control modules with the naming convention
described previously. It will then take all of those files and place them in a compressed .zip file on the user's Desktop named with the system file name followed by the timestamp at the time of
creation.
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